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Introduction 
When DVD Architect 1 software was released about a year ago as of the writing of this 
document, the industry was stunned and impressed with the quality of the software for a first 
version. But there were a few holes. Just a couple of functions lacking that kept users saying, “I 
wish that I could…” 

Version 2 completely plugs those holes and more. Those who found version 1 lacking in a couple 
important areas will wholeheartedly welcome major additions to the software like subtitling and 
additional audio tracks. The addition of user-definable end actions open up a world of 
sophisticated navigation possibilities, and give you, the author, great control over the viewing 
experience of the end user. 

Other enhancements to the software put a powerful new spin on old functionality. For instance, 
the Project Overview window makes it easy to quickly construct the rough outline of your project 
so that you can fill in the details later. It also serves as a great navigational tool that helps you get 
around your project quickly. The Timeline window gives you a quick way to make adjustments 
to your media files, menus, and compilations. The Properties window might be considered the 
Swiss army knife of the program where you can enjoy unprecedented control over your project. 

You’ll also enjoy new file format support such as Macromedia Flash (.swf), elementary stream 
MPEG files, and support for 24p video. DVD Architect 2 software also supports all valid DVD 
video resolutions: NTSC — 720x480, 704x480, 352x480, 352x240 (24 & 29.97fps) and PAL — 
720x576, 704x576, 352x576, 352x288 (25fps). 

With all of this, in addition to a new, customizable interface, you’re going to love DVD Architect 
2 software. If you thought version 1 was impressive, wait until you learn how to use version 2! 

To that end, this document gives you all of the information you need to truly master the new 
features. We’ll walk you through each new feature with plenty of examples that you can follow 
right along with for a thorough, hands-on education. We suggest that you open this document 
and DVD Architect software on your computer at the same time, and switch back and forth as 
you try the next step in the process. Follow our instructions, and you will learn the ins and outs 
of all of the new features. 

We do want to mention that this document was written under the assumption that you already 
have a working knowledge of DVD Architect 1 software. We necessarily have to take for granted 
that we can gloss over some steps that you know from your experience with version 1, or this 
document would be a book instead of a document! If you don’t have a working knowledge of 
version 1, you will still be able to use this document. However, you may need to refer to the on-
line help files now and then to fill in some of the gaps between your knowledge and our 
assumption of your knowledge. 

So, let’s get started with our discussion of the new features of DVD Architect 2 software. We hope 
you enjoy this document and find it helpful, and we wish you all the best of luck with your 
future DVD projects. Thank you for your support for DVD Architect 2 software, and all of the 
Sony Media Software products! 

 

Gary Rebholz and Michael Bryant 

Sony Pictures Digital 
Media Software Consulting and Training
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I: Enhanced user interface 
It won’t take long before you notice that DVD Architect software has received a fairly substantial 
facelift. It might take a bit of getting used to, but soon you’ll find that the intuitive look and feel 
of DVD Architect 1 software lives on in version 2 with some exciting modifications that make the 
new version even more powerful than the original. We’ll start with a few significant changes that 
have been made to the menus. From there we’ll explore all of the other interface enhancements.  

The View menu 

The View menu has received a major overhaul. For starters, it now contains a new 
submenu, the Workspace Overlays submenu. The Workspace Overlays menu brings together 
several related options that were previously spread across different menus, making for a more 
logical grouping and easier location of these tools. These options turn on and off helpful guides 
that do not appear on your final DVD, but give you valuable information during the DVD 
assembly process. The following list gives a brief description of each of the options available 
under the Workspace Overlays submenu of the View menu. Note that each of these options was 
also available in version 1 with the exception of the brand new Show Button Masks option 
(located at the end of the list.) 

• Show Title Safe Area: this overlay gives you a guide for placing text safely within the 
visible area of a television screen. It leaves enough space between your text and the 
actual visible edge of a television screen so as to make sure your text is easy to read on 
screen. You should not position text outside of the box defined by this overlay. You can 
change the size of the Title Safe Area through the Editing tab of the Preferences dialog 
under the Options menu, but in most cases, you should just leave these settings.  

• Show Action Safe Area: this overlay defines a slightly larger area than the Title Safe 
Area overlay. It represents the approximate edge of a standard television screen. You 
should position your graphics such that no critical information lands outside of the box 
defined by this overlay. You can change the size of the Action Safe Area through the 
Editing tab of the Preferences dialog under the Options menu, but again, you should 
normally leave it as the default.  

• Show Object Order: object order refers to the layering of objects on your workspace. An 
object (for instance, a button or a graphic) with a higher object order number obscures 
any object with a lower object order number if the two objects occupy (or partially 
occupy) the same physical space. You can change the object order of an object through 
the Edit menu. 

• Show Grid: this overly helps you properly align the objects in your workspace. You can 
adjust the grid settings through the Grid Settings option under the Options menu. 

• Show Button Masks: this overlay—new to version 2—helps you when working with 
invisible buttons. You would add invisible buttons if you’ve used a graphics program to 
create custom button artwork, and simply need an invisible button to act as a link on 
your DVD. Much has been added to version 2 to make this process extremely powerful, 
so we’ll talk more about this later in this document. For now, we’ll just point out that you 
can choose this option to show button masks. 
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The bottom portion of the View menu contains a number of new options. These options show or 
hide windows in the interface. We’ll talk about each of the windows listed in this section of the 
View menu later in this document, so we won’t spend time on each of them here. Rather, we’ll 
simply point out that the View menu in version 2 works much more like the Vegas software’s 
View menu in that it enables you to hide and show windows that you’ll use to construct your 
DVD projects.  

The Insert menu 

The Insert menu contains one new option in version 2. Choose Insert | Empty Button to 
add a button to your workspace that does not link to any specific media or contain any thumbnail 
image. You might choose to do this if you want to design your DVD layout and know you’ll need 
the button, but have not completed the movie to which the button will link. Later in this 
document we’ll discuss techniques for assigning a link to an empty button. 

The Options menu 

Some options that appeared under the Options menu in version 1 now appear under the 
View menu. Notice that one new option now exists under this menu. Choose Options | Preview 
to External Monitor to set DVD Architect software to preview your DVD on an external NTSC or 
PAL monitor through your IEEE 1394 device (just as you do in Vegas software.) Later in this 
document we devote an entire section to this topic.  

Also under the Options menu, the Preferences dialog now contains two new tabs. The first of 
these, the Video Device tab, relates to external monitor preview. As mentioned, we’ll discuss that 
feature in detail later in this document.  

The other tab, the Display tab, provides tools with which you can customize the color of the 
buttons in the DVD Architect application interface. To see how this works, first let’s make sure 
that your project looks like ours. (We’ll assume that if you are using XP you have the desktop 
theme set to Windows XP and if you are using Windows 2000 it’s set to Windows Classic.) Click 
the New Project button to start a new project. Choose Options | Preferences to open the 
Preferences dialog, and then click the Display tab. The Icon Color Saturation slider gives you 
control over the intensity of the color of your buttons. Position the Preferences dialog so that you 
can see the buttons at the top of the Project Overview window as shown in Figure 1. Note the 
colors of these buttons. Now, drag the Icon Color Saturation button all the way to the left (0%) 
and click the Apply button. The color has been removed from the buttons, and the elements that 
were once in color now appear shades of gray as in Figure 1. Next, drag the Icon Color 
Saturation slider all the way to the right (100%) and click the Apply button. Notice the more 
vibrant colors in the buttons now as in Figure 2. 

Figure 1 
With the Color Saturation slider all the way to the left, the buttons look grey.  
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Figure 2 
With the Color Saturation slider all the way to the right, the buttons have more vibrant colors. 

 

The Icon Color Tint slider yields much more subtle results when you’ve got Windows configured 
with its default colors. This slider adds a tint to the DVD Architect application’s buttons. Your 
Windows color scheme determines the tint that this buttons adds. Notice the color of the title bar 
at the top of the Preferences dialog. By default, this bar is a gradient that starts with light blue at 
the top, blends to dark blue in the middle, and then blends back to dark blue at the bottom (in 
Windows 2000, the title bar starts from dark blue on the left end and ends with light blue on the 
right end.) The Icon Color Tint slider adds a tint made up of the average values of these Title bar 
colors to the DVD Architect application buttons. 

To really notice the effects of this slider, change the colors assigned to window title bars by the 
operating system. To do this, open the Windows Control Panel, and then double-click the 
Display icon to open the Display Properties window. Click the Appearance tab. From the Color 
scheme (in Windows 2000, it’s the Schemes) drop-down list, choose Default (in Windows 2000, 
choose Windows Standard) if it’s not already chosen. In Windows XP, click the Advanced 
button. 

From the Item drop-down list, choose Active Title Bar. To the right of the Item drop-down, 
notice the two color boxes. Click on the first color box, and choose a red color square from the 
choices that appear. Click the second color box, and choose a yellow color square. In Windows 
XP, click the OK button. If necessary, click the Apply button in the Display Properties window to 
assign this color scheme to your Windows title bars. Now, return to the Display tab of the DVD 
Architect application’s Preferences dialog. Adjust the Icon Color Tint slider all the way to the 
right (100%,), click the Apply button, and notice that now your buttons contain an entirely new 
tint. If you don’t want to keep these new settings, return to the Appearance tab of the Display 
Properties window and choose your desired color scheme from the Color scheme drop-down (in 
Windows 2000, from the Scheme drop-down list.) Finally, click the Apply button to set Windows 
back to standard colors, and the OK button to dismiss the Display Properties window. 

Dockable windows 

One quick glance around the DVD Architect screen reveals several new windows. These 
windows bring powerful new functionality to the application. We’ll discuss each of these 
windows later in the document. For now, we’ll talk about how you can customize the window 
arrangement on your screen to suite your editing and working style. 

DVD Architect software now features the same window docking behaviors as Vegas software—
including the enhancements in version 5 of the Vegas application. Therefore, you already know 
the basics of how to use docking windows from your work in earlier versions of Vegas software. 
In addition, the DVD Architect also features a docking behavior that has previously been specific 
to Sound Forge software: the ability to dock windows to any edge of the application window as 
opposed to just the bottom edge as in Vegas software.  
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All of the windows that appear in the View menu can be opened and closed through that menu. 
The following list specifies the windows, and gives brief descriptions along with the docking 
locations at which you’ll find them when you first open the application. 

• Explorer: docked to the lower-left-hand corner of the application window (the same 
location it occupied in version 1.) Use the Explorer window to navigate to files that you 
want to add to your project. 

• Themes: docked to the lower-left-hand corner of the application window beneath the 
Explorer (the same location it occupied in version 1.)  Click its tab to bring it to the front 
of the docking area. Use the Themes window to apply a default graphical look to your 
project. 

• Buttons: new to version 2. Docked to the lower-left-hand corner of the application window 
beneath the Explorer, this window provides quick access to all of the button styles 
included in version 2. Click its tab to bring it to the front of the docking area. From here 
you can add buttons to your project, change the style of an existing button, remove the 
frame from a button, and more. 

• Backgrounds: new to version 2. Docked to the lower-left-hand corner of the application 
window beneath the Explorer, this window enables you to replace the background 
images on your menus without applying a new theme to the menu. Click its tab to bring 
it to the front of the docking area. 

• Compilation: new to version 2. Docked to the upper-right-hand corner of the application 
window beneath the Properties window. Use this window to add songs to build your 
music and picture compilations. It becomes active when you navigate into a compilation 
link. 

• Properties: new to version 2. Docked to the upper-right-hand corner of the application 
window. One of the most significant additions to version 2, the Properties window acts 
as somewhat of a command center for your project where you make decisions about 
everything from graphics to audio to highlight colors to end actions. 

• Timeline: new to version 2. Docked to the lower-right-hand corner of the application 
window. Another significant addition to the new version, the Timeline has a similar 
purpose in your DVD Architect software project as the Vegas software’s timeline has in 
that application. Here you add audio and video elements to your menus and links, 
determine in and out points, and add chapter markers and subtitles. 

• Project Overview: new to version 2. Docked to the upper-left-hand corner of the 
application window. This window provides a tree structure view of your entire project 
that helps you understand at a glance exactly how the project is assembled and 
organized. You can edit the structure of your project directly from this window. 

As the list indicates, each of the windows docks to a different area of the application window. 
However, you can tear these windows from their docking locations and either dock them to a 
new area, or allow them to float freely anywhere on your computer screen (or another screen in a 
dual-monitor setup.) 

To undock a window from its docked location, click and drag the drag handles. Six horizontal 
dots at the top-right corner of a window that is docked to either side of the application window, 
or six vertical dots along the left edge of a window that is docked to either the top or bottom of 
the application window identify the drag handles for the window as shown in Figure 3. When 
you move the window far enough away from an edge of the application window, a title bar 
appears above the window. The appearance of the title bar indicates that you can release the 
mouse button to leave the window floating in that location. When you get close enough to a side 
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of the application window, the title bar disappears, and you can release the mouse button to dock 
the window to the new location. If you want to position a window very close to an edge of the 
application window, but want it to remain floating instead of docked, hold down the Ctrl key to 
override the normal docking behavior. 

Figure 3 
The six horizontal or vertical dots represent the Docking Handles. 

 
Horizontal Docking Handles 

 

Vertical Docking Handles 
 

Floating Docks 

DVD Architect software now also supports floating docks. This feature breaks the 
limitation of docking windows only to the sides of the application window. With floating docks, 
you add two or more windows to a docking group that you can move to any location on your 
computer monitor or monitors. 

As an example, let’s create a floating dock that holds the Explorer window and the Properties 
window. First, tear the Explorer window from its docking location at the bottom of the screen, 
and position it toward the middle of your computer screen (or, better yet, on a second monitor if 
you have a dual-monitor setup) so that when you release the mouse button the Explorer window 
floats freely on the screen. Now, tear the Properties window from its location, and drag it directly 
on top of the floating Explorer. You’ll know you’re in the right spot when the Properties 
window’s title bar disappears and docking handles appear. Release the mouse button and the 
two windows now share a floating dock. Since you docked the Properties window directly on top 
of the Explorer window, you can no longer see the Explorer. Click the Explorer window’s tab at 
the bottom of the floating dock to bring that window to the front. You can add as many windows 
to a floating dock as you want. 

As with other docking areas, you can add as many sections to a floating dock as you want. You 
still have the Properties window and the Explorer window docked in a floating dock. Click the 
Properties window’s tab to bring it to the front. Use the docking handles to tear the Properties 
window away from the floating dock, then drag the window back to the floating dock, but this 
time, drop it somewhere on the right half of the Explorer. This creates a floating dock again, but 
this time the two windows occupy their own sections in the floating dock so that they do not 
obscure one another. 

Don’t forget that if you want to stack one window on top of another without creating a floating 
dock, hold down the Crtl key before you release the mouse button to drop the window. 

The next time you open DVD Architect software, all windows open exactly as you last arranged 
them. If you want to quickly return to the default layout, hold Ctrl+Shift  as you start the 
application.  
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II: Workflow enhancements 

Saving media assets with project 

You can now save your DVD Architect software project to a new location and 
automatically copy the media assets you’ve used in your project to that same location. This 
functionality makes it very easy to archive your project or to move it to another computer where 
you intend to work on it further. The feature ensures that you don’t accidentally neglect to copy 
all of the necessary media along with the project file. 

To save your project along with all of the media used in the project to a new location, choose File 
| Save As. You’re well familiar with the Save As dialog, so we won’t walk through all of its 
features. We do want to point out the Copy Media drop-down list at the bottom of the Save As 
dialog. The following list shows the three options available under the Copy Media drop-down 
list, and explains what the options do. 

• Normal: this option causes the Save As dialog to act just as it did in version 1. Choose 
this option if you want to save the project file to a new location or with a different name, 
but do not want to copy the media assets used in the project to the save location. 

• Copy user media with project: choose this option if you want to copy all of the media 
files that you use in the project to the save location. You’ll likely choose this option when 
transferring the project to another computer where you intend to continue working on it. 
If the second computer has all of the files that the DVD Architect installer places on the 
machine, you have no reason to copy theme elements to that computer. 

• Copy user and theme media with project: choose this option if you want to copy all of 
the media files and theme elements that you use in your project to the save location. The 
most likely use for this is for archiving a project where you want make sure that you 
archive every piece of media—whether your own or theme elements—that you used in 
the project. 

External monitor preview 

External monitor preview support enables you to preview your DVD project on an 
external NTSC or PAL monitor so that you can see exactly what it will look like once you burn it 
to a DVD. This provides tremendous advantage because you need no longer guess at what your 
project will look like to someone viewing it from the burned DVD. You can now accurately 
preview positioning of menu items, colors, text and so on, thus removing all of the guesswork 
during the DVD authoring stage. 

To preview your project on an external monitor, you’ll need to convert the digital signal from 
your computer into an analog signal that your external monitor can read. If you’ve ever used the 
external monitor preview feature in Vegas software, you’ll find the procedure for previewing to 
external monitor in DVD Architect software just as simple to set up and use.  In fact, you use an 
identical setup and procedure in both applications. 

First, use an IEE1394 (i.LINK) cable to connect your computer’s IEEE 1394 card to the i.LINK 
input of your DV camcorder (set your camcorder to VCR or VTR mode), DV video cassette 
recorder, or DV to analog converter. These devices act as digital to analog converters, which take 
the digital signal coming from your computer and convert it to an analog signal that your 
external monitor can read. We’ll call them D/A converters in this discussion. (The D/A converter 
device you use must support pass through—in other words, it must receive a digital video signal 

 

11



DVD Architect 2 learn to use the new features 

through its digital inputs, convert the signal to analog, and then pass the analog signal out of its 
analog outputs.) 

Next, use an analog cable (such as an S-video or composite cable) to connect the analog outputs 
of your D/A converter to the NTCS or PAL monitor. Switch the D/A converter and the external 
monitor on. 

This setup sends the video stream from DVD Architect software to the external monitor, but does 
not send the audio stream. The audio stream routes through your normal audio previewing setup 
(from your computer sound card to your speakers.)  

With the hardware in place as described above, you can use two techniques for previewing to the 
external monitor. The first technique enables you to view the DVD Architect software workspace 
on the external monitor. This is useful during the authoring stage of your workflow. Choose 
Options | Preview on External Monitor. This opens the Preferences dialog with the Video 
Device tab active (assuming this is the first time you’ve ever chosen this option.) From the Device 
drop-down list, choose the IEEE 1394 card to which you have your D/A converter (and thus the 
external monitor) connected-most users will need to choose OHCI Compliant IEEE 1394/DV, 
which may be the only device listed.  The Details area gives you some information about the 
device you’ve connected to the system, and whether DVD Architect software has detected that 
the device is connected. From the Format drop-down, choose from the standard DV or 
widescreen DV options for either NTSC or PAL. Most users will pick the appropriate version of 
standard DV. 

Click the OK button to dismiss the Preferences dialog and activate external monitor preview. You 
can now view the workspace on your external monitor. This enables you to design the graphical 
layout of your DVD and see exactly what it will look like on a television screen. 

One important difference between previewing on an external monitor in Vegas software and 
DVD Architect software involves audio/video sync. DVD Architect software does not attempt to 
maintain perfect sync between the video being sent to the external monitor and the audio 
generated through your sound card. Syncing issues are just not as critical at this stage of the 
process as they are when editing the video in Vegas, and therefore system resources are not 
devoted to maintaining sync. The real purpose of external monitor previewing in DVD Architect 
software is to provide an accurate image of the project layout and graphic design so that you can 
make any necessary adjustments before spending the time to encode and burn the DVD. 

To use the second technique for previewing to an external monitor, which is useful when you 
want to preview and test your DVD creation, click the Preview button in DVD Architect 
software. This opens the familiar DVD Architect software preview window and virtual remote 
control device. In the button bar (above the virtual remote control), click the Preview on External 
Monitor button, shown in Figure 4. 

Figure 4 
Click the Preview on External Monitor button to send a preview out to an external monitor. 

 
Preview on External Monitor 

 

As described above, if you’ve never assigned a device on the Video Device tab of the Preferences 
dialog (or if you’ve reset your preferences to their default values since the last time you used the 
external monitor preview function), that tab opens automatically when you click the Preview on 
External Monitor button. If you’ve already assigned the device, DVD Architect software 
remembers that device assignment, and you don’t have to choose it again. Since you already 
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assigned the device during our discussion above, your project begins previewing on your 
monitor immediately. Should you ever need to visit the Video Device tab of the Preferences 
dialog again, close the DVD Architect Preview window and choose Options | Preferences to 
open the Preferences dialog. Then click the Video Device tab. 

III: The Project Overview window 
The Project Overview window provides an easy-to-interpret map or outline of your project 
presented in a familiar tree-view layout. You can use this window to check over the structure of 
your DVD, add and delete menu items from your project, reorganize menu items, and more. To 

 hide the Project Overview window, choose View | Project Overview.  show or

Becoming familiar with the Project Overview window 

The Project Overview window shows all of the menus, movie files, links, photo 
compilation links, and music compilation links that you add to your project. You also have the 
option of showing or hiding any end actions that you’ve applied to menus or media items (we’ll 
talk in detail about end actions later in this document.) 

The tree structure used in this window follows the same conventions as that used in the Explorer 
window. As in the tree structure for the Explorer window, you can collapse and expand levels, 
drag items from one level to another, delete items, and so on. Let’s start with a tour of what you 
see in the Project Overview window when you first start a new DVD project. 

Exploring the default project layout 

Every new project has a simple structure already in place. In the Workspace you see the 
default menu, Menu 1. It uses the default background image (from the default theme), and 
contains a text box that identifies this as Menu 1. Now look in the Project Overview window. 
Here you see the simple hierarchical structure of your project. Let’s start from the bottom and 
work our way up the tree. The window shows that Menu 1 (Page 1) lies nested within a folder 
called Menu 1. 

Why are there two items called Menu 1? Remember from using version 1 that you can insert 
multiple pages into a menu. By default, Menu 1 consists of just one page, but if you need more 
room for all of the links that you want to put on Menu 1, you could inset a new page to Menu 1. 
Notice the difference between the icons used for the item Menu 1 (Page1) and the item called 
simply Menu 1. The folder icon for the Menu 1 item indicates that it holds all of the pages that 
make up that entire menu group.  When you insert another menu page to the Menu 1 folder, the 
new menu page exists on the same level as Menu 1 (Page 1). 

Inserting a new menu page 

You can easily see the relationship between multiple pages of the same menu in the 
Project Overview window. Let’s use the Project Overview window to insert an additional page to 
Menu 1 now. Right-click the Menu 1 folder, and choose Insert | Menu Page from the pop-up 
menu. Now look back to the Project Overview window. You now see several new items in the 
structure outline for your DVD. Most notably, a new icon labeled Menu 1 (Page 2) appears at the 
same hierarchical level as Menu 1 (Page 1) under the Menu 1 folder. 

You also see two links displayed in the Project Overview window once you add the new menu 
page. These appear because DVD Architect software automatically places navigation buttons on 
both menu pages so that your user can navigate between the two pages. You can see these 
navigation buttons in the workspace window (they appear as arrows.) Notice that the tree view 
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shows these two links one level in from the menu pages upon which they sit, so you can easily 
see their relationship to the rest of the project. 

Navigating through your project structure 

Notice that the Menu 1 (Page 2) label is bold compared to the Menu 1 (Page 1) label. This 
indicates that the workspace currently shows page 2. Double-click the Menu 1 (Page 1) icon to 
navigate to page 1. You can also double-click the icon for any media, picture compilation, or 
music compilation in your project to navigate into that item. When you double-click a link in the 
Project Overview window, you follow that link. In all of these cases, you can also right-click and 
choose Navigate Into (or, in the case of a link, Follow Link) to achieve the same results as a 
double-click on the item. If you ever find yourself unsure of just where in your project hierarchy 
you are, take a quick look at the Project Overview window and find the bolded item. That’ll let 
you quickly see exactly where you are in your project.  

Inserting a submenu and compilations 

One approach to building your DVD interface is to use the Project Overview window to 
quickly build the skeletal structure of your DVD. You can quickly insert submenus, both picture 
and music compilations, and specific media files to your project without ever leaving the Project 
Overview window. Then you can go to the workspace and adjust the graphic layout of these 
items and the links to them. This section discusses how to add each of these items (with the 
exception of adding media, which we’ll discuss in the following section) from inside the Project 
Overview window. 

Sometimes you don’t want a new menu page like the one we inserted earlier, rather you want a 
unique submenu attached to a menu. You can easily insert a submenu from the Project Overview 
window, so let’s do so now. Double-click the icon for Menu 1 (Page 1) to navigate into that menu 
page. Now right-click the Menu 1 (Page 1) icon and choose Insert | Submenu from the pop-up 
menu. A new menu folder (Menu 2) and the structure of everything that goes along with it now 
appears one level in from the level of Menu 1 (Page 1) indicating that Menu 2 is a submenu of 
Menu 1 (Page 1). Look at the workspace to see that a link has been added to the menu. This link 
leads to the new submenu. 

You probably noticed in the pop-up menu for Menu 1 (Page 1) that you can insert several other 
items to Menu 1 with the right-click method too. The Project Overview window gives another 
way to accomplish these tasks: insert buttons. A series of buttons appears at the top of the Project 
Overview window. With Menu 1 (Page 1) still selected in the tree list, click the Insert Picture 
Compilation button, shown in Figure 5. This inserts a picture compilation into your project as 
indicated by the new item in the tree view (3: Picture Compilation 1) and the link that has been 
added to the menu in the workspace. 

Figure 5 
Click the Insert Picture Compilation button to create a Picture Compilation object in your project. 

 

 
Insert Music Compilation 

Insert Picture Compilation 

Next, click the Insert Music Compilation button to insert a music compilation to your project 
and a link to it on Menu 1 (Page 1). At this point, you’ve merely created the structure to support 
the picture and music compilations that you want to create on your DVD. Later we’ll discuss how 
you can use the new Compilation window to populate your compilations. 
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Inserting Media 

There’s a little more to inserting media into your project through the Project Overview 
window than there is to inserting the items we’ve talked about thus far. When you insert media 
to your project, you must naturally specify which media you want to add. Double-click the icon 
for Menu 1 (Page 2) to navigate to that menu page. Click the Insert Media button Figure 6. This 
opens the Insert Media dialog. This familiar dialog style gives you a way to navigate to the media 
on your computer drives that you want to insert. For now, navigate to any .avi or .mpg video file 
on your computer drive(s) and select it in the dialog. Click the Open button to insert the selected 
file into your project. An icon for the media file appears in the tree structure, and a link to the 
media file appears on the menu in the Workspace. 

Figure 6 
Click the Insert Media button to add audio, video, or still-image files to your project. 

 
Insert Media 

 

Inserting a new menu 

Earlier, you learned how to add a new page to an existing menu. You can also add an 
entirely new menu to your project. One level up from the Menu 1 folder—at the very top level of 
your DVD project tree—you see a disc-shaped icon with the label Untitled Figure 7. This icon 
represents your entire project. When you save your project—and thus give it a name—the project 
name replaces the label Untitled. To add another menu to your project, right-click the disc icon 
and choose Insert Menu from the pop-up menu.  

Figure 7 
To add another menu to your project, right-click the disc icon at the top of the Project tree and choose Insert Menu from the pop-
up menu.  

 

Disc Icon 

You see that your project now has another menu (Menu 3) at the same hierarchical level as the 
original menu (Menu 1.) 
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Inserting a scene selection menu 

If you’ve added a movie file to your project that contains several chapter markers, it can 
be beneficial to include a scene selection menu on the DVD so that the viewer can navigate 
directly to a specific scene. You can still automatically create a scene selection menu using the 
same techniques you used in version 1, but in version 2 you can also accomplish the task through 
the Project Overview window. 

Double-click the icon for Menu 3 (Page 1). Click the Insert Media button. In the Insert Media 
dialog, navigate and insert a movie file that contains chapter markers (remember, when you 
render files in Vegas, you can choose to save your Vegas software project markers along with the 
file, and DVD Architect software then recognizes those markers as chapter markers.) Now, click 
the icon, in the workspace, for the media file that you just added. Notice that this selects the 
media file icon, but does not navigate into the media file as a double-click would. You can see by 
the bolded text that you are still navigated into Menu 3 (Page 1), but by the highlighted text that 
you have selected the media file to work on. 

Now, click the Insert Scene Selection Menu button shown in Figure 8. In the Insert Scene 
Selection Menu dialog, specify the number of links per page (typically, this corresponds to the 
number of chapter markers in your media file.)  Click the OK button. A new menu entitled Scene 
Selection (Page 1) has been added to your project. Double-click the icon for the Scene Selection 
(Page 1) menu to navigate into that menu, and you see that the menu contains the links that DVD 
Architect software has automatically created for you based on the chapter markers in the media 
file. 

Figure 8 
Click the Insert Scene Selection Menu button to open the Scene Selection Menu dialog. 

 

Insert Scene Selection  

You might want the link to the scene selection menu to be on the same menu as the link to the 
entire movie--Menu 3 (Page 1). Double-click the Scene Selection folder icon to navigate to that 
menu. Then, drag the icon for the Scene Selection folder and drop it onto the Menu 3 folder icon. 
The Scene Selection menu now appears as a submenu of Menu 3. 

Specifying the DVD start item 

If you’ve been following along with our discussion, you now have a DVD project that 
contains two menus. One of those menus contains two menu pages, and one of those menu pages 
contains a submenu. With one notable exception, the tree structure uses the same icon to identify 
each of these menu-related objects. That exception relates to the DVD start item. 

The DVD start item is simply the object that automatically plays when the user inserts the DVD 
into a player. When you begin a new project, Menu 1 (Page 1) automatically becomes the DVD 
start item. Unless you’ve done something to change the DVD start item, and you’ve followed our 
instructions so far, the icon for Menu 1 (Page1) in the project we’ve been building contains a 
white star inside a purple square as shown in Figure 9. This indicates that Menu 1 (Page 1) has 
been designated as the DVD Start item. To check this, click the drop-down arrow next to the 
Preview button in the main toolbar, and choose Preview Disc from the drop-down menu. The 
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Preview window and virtual remote control open, and you can see that Menu 1 (page 1) shows 
up in the Preview window. Click the Close button to close the Preview window. 

Figure 9 
The white star inside the purple square indicates the Start Item—the first item to play on the DVD. 

 

Start Item 

You can designate any menu or media item to be the DVD start item. Let’s change the DVD start 
item of our project now. Double-click on the icon for Menu 3 (Page 1). Now, click the Set DVD 
Start button at the top of the window. The DVD start item designation icon moves from Menu 1 
(Page 1) to Menu 3 (Page 1). Now choose Preview Disc again, and see that you now see Menu 3 
(Page 1) before anything else. Close the Preview window. 

Experiment with making various elements in your project the DVD start item. Notice that you 
can make any menu page, compilation, or media file the DVD start item, but you cannot make a 
link the DVD start item. 

Inserting introduction media 

The Insert Introduction Media button provides a way for you to add media to your 
project and make that media the DVD start item all in one operation. Click the Insert 
Introduction Media button shown in Figure 10. This opens the Insert Media dialog that you saw 
earlier. Navigate to a media file, and click the Open button to insert that file into your project. 
DVD Architect software inserts the media on the first level of the disc (the same level as Menu 1.) 
Notice that the media’s icon contains the DVD start item indicator.  

Figure 10 
Click the Insert Introduction Media button to insert a media file that will automatically play when the DVD is started. 

 
Insert Introduction Media 

 

We sometimes refer to a media file inserted with this method as first play media because it plays 
automatically and before anything else happens. This is a great place to put a short copyright 
notice, your production company’s logo, and other objects that aren’t really part of the DVD 
presentation, yet are still important to include on your disc. 

 

17



DVD Architect 2 learn to use the new features 

Displaying End Actions 

DVD Architect 2 software boasts powerful new end actions that give you a greater level 
of control over the viewing experience of your DVDs. We’ll talk in much more detail about them 
when we discuss the Properties window later in this document. For now, a brief description will 
be helpful in understanding their relationship to the Project Overview window. Simply put, end 
actions enable you to specify the exact action that takes place once a menu or a media file finishes 
playing. For example, you could set the end action of a menu to wait for a specified period of 
time, and then (if the viewer hasn’t selected any of the menu options) have the DVD 
automatically pick the menu option you specify in the end action. Or, you could set the end 
action of a media file so that it returns to a specific menu or runs another media file when it 
completes. 

You can display your project’s end actions in the Project Overview window. To show end actions, 
click the Toggle Display of End Actions button, shown in Figure 11. End actions now show up 
in the tree structure. If you’ve followed our instructions so far, you have a couple of media files in 
the project you’ve been building. Those media files contain default end actions, and you see them 
listed when you toggle end actions display on. To hide end actions in the Project Overview 
window, click the Toggle Display of End Actions button again. 

Figure 11 
Click the Toggle Display of End Actions button to show or hide end actions in the Project Overview window. 

 
Toggle Display of End Actions 

 

IV: Buttons and Backgrounds 
The new Buttons and Backgrounds windows give you more flexibility than ever in designing the 
look of your DVD. This section discusses these two windows. 

Working with button styles 

The Buttons window contains all of the familiar button types that you used in version 1. 
The window provides a more powerful way to work with your buttons and their 

frames. Choose View | Buttons to open or close the Buttons window. By default the window sits 
docked in the lower left-hand corner of the application window beneath the Explorer window. 
Click the Buttons tab to bring the Buttons window to the front. 

If you haven’t done so already, click the New Project button to start a new project. You can use 
the Buttons window to quickly add empty buttons to the selected menu. For instance, in a new 
project, you have a one-page menu, Menu 1 (Page 1). In the Buttons window, click on the 
thumbnail for the button that contains the frame style you want to use on your buttons. Click the 
Insert Button button, shown in Figure 12 to add a button with the selected frame (and a text box) 
to your project. Click the Insert Button button as many times as you need to in order to add the 
number of buttons you need in your project. You can also drag a button from the Button window 
directly to the workspace to add it to your project. 
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Figure 12 
The tool bar at the top of the Buttons window contains tools for adding, replacing, deleting, and viewing the buttons. 

 

Category Selection 
Dropdown 

Show All Buttons 

Show Non-Framed Buttons 

Show Framed Buttons 

Remove Frame 

Replace Button 

Insert Button 

 

The buttons you add with this method do not contain any thumbnail image, nor do they link to 
workspace. Once you’ve added the buttons you want, you can use the Properties window (which 
we discuss in detail later t) to modify those buttons as necessary and make them do what you 
want them to do. For now, just leave the button blank. We’ll work with it a bit more to 
demonstrate the functions of the Buttons window. 

You can change the button style of any button you’ve already added to your workspace. First, 
click the button in the workspace to select it (or selected multiple buttons if you want to change 
several to the same style all at one time.) if it is not already selected. Now, click the button style 
from the Button window that you want to use instead of the current style. Click the Replace 
Button button. This updates the button style with the selected style. You can also double-click 
any button style in the Buttons window to change the buttons style of every button selected in the 
workspace. 

If you decide that you don’t want any graphic at all on an existing button, select the button in the 
workspace, and click the Remove Frame button. This creates an invisible button. You can lay 
invisible buttons over custom background artwork if you want to create the graphic element of 
the buttons in an image- editing program or in Vegas software.  

You can limit the button styles that the Button window shows to make it easier to pick a style if 
you know generally what you’re after. There are two ways to do so: you can limit the buttons 
shown by style (that is, whether the button style has a frame or not) or by theme and collection 
association. 

First, to show just the buttons styles with frames, click the Show Framed Buttons button. To 
show just the buttons styles with no frames, click the Show Non-Framed Buttons button. The 
non-framed buttons generally give you arrow options that you can use for building your DVD 
navigation interface. To show all button styles (framed and non-framed), click the Show All 
Buttons button. 
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You can also limit the buttons shown in the Buttons window according to their theme or 
collection association. To do this, choose an option from the Location drop-down list. For 
example, click the Location drop-down list, and choose Wedding from the list.  

Notice that the three Show buttons effect the button graphics you see when you choose an option 
from the Location drop-down. For example, with Wedding still chosen in the Location list, click 
the Show Framed Buttons button. You see just three button styles in the window. Next, click the 
Show Non-Framed Buttons button. You now see four different button styles. Finally, click the 
Show All Buttons button, and you see all seven available buttons for that button source. To see 
every button style available, click the Show All Buttons button, and then choose All Sources 
from the Location dropdown list. 

Adding stock backgrounds 

Recall from version 1 that you can quickly add one of the stock themes included with 
DVD Architect software (or any of your custom themes) to achieve a unified look for your 
menus. Of course, you can still do that in version 2 through the Themes window. But now you 
can use the Backgrounds window to change the background image regardless of the theme you 
use. Let’s see how it works. 

Click the New Project button to start a new DVD project. DVD Architect software uses the 
default theme. Choose Insert | Empty Button to add a button to the menu. Notice that for the 
default theme, the button has no graphic. Now choose Insert | Next Button and Insert | 
Previous Button to add those buttons to the menu. Note the graphics used for these two buttons. 

As with version 1, you can change the theme you use on this menu. Click the tab for the Themes 
window to bring it forward, and then click and drag the theme Album to the workspace. Notice 
that not only does the background image change, but so also do the graphics used for the three 
buttons on the page. 

Now, look at the thumbnail for the theme Animated 1 in the Themes window. Notice the 
different button graphics used on that theme. Drag the Animated 1 theme to the workspace, and 
see that the background and button graphics change again to match the theme. Click the Undo 
button in the main toolbar to go back to the Album theme. 

Now, let’s change the background without changing the button graphics. Click the Backgrounds 
tab to bring the Backgrounds window to the front. This window shows you the available 
backgrounds, and you notice immediately that these backgrounds match the backgrounds used 
in the various themes (including all of your custom themes.) Assuming you have not changed the 
order by adding your own custom themes, the background graphic that occupies the middle 
position on the top row is the same graphic used in the Animated 1 theme that you dragged onto 
the menu just a few minutes ago. Drag that thumbnail to the workspace. This time, notice that 
although the background changed to the one you dragged to the workspace, the button graphics 
did not change: they are still those used by the Album theme. Choose Insert | Empty Button and 
notice that the new button still conforms to the active theme (Album) even though the 
background uses a different graphic. 
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V: The Timeline window 
You’ll find several of the most exciting new features of DVD Architect 2 software in the powerful 
new Timeline window. Through this window you can work with chapter markers, adjust the in 
and out points of your media, add multiple audio tracks to your video media, and create multiple 
subtitle tracks that overlay the video portion of the media when played back on a television. 
You’ll notice that working in the Timeline window feels very much like working in the timeline 
of a Vegas software project. Differences naturally exist, but you’ll feel right at home with the 
track headers, video thumbnails, audio waveforms, navigation techniques, zoom techniques, and 
more. In this section, you’ll learn how to use the Timeline window to easily and intuitively 
accomplish sophisticated DVD authoring tasks. 

Becoming familiar with the Timeline window 

Click the New Project button to start a new DVD project. As usual, your project contains 
one menu, and that menu uses the default theme and its corresponding background. Since you 
have no other elements in your project, the Timeline window currently shows you the makeup of 
your menu. Notice that menu contains one video track (which currently holds the default 
background media), and one empty audio track. 

You can use the Timeline window to quickly change the media that you want to use for the menu 
background and to add an audio track to the menu. First, let’s change the image we use for the 
background of the menu. As in version 1, you can drag a still-image file to the workspace in 
order to replace a menu background. Now, you can also drag the file to the video track in the 
Timeline window to achieve the same results. In the Explorer window, navigate to a still-image 
file and drag it to the video track in the Timeline window. 

In the same way, you can quickly add audio to your menu. Use the Explorer window to navigate 
to an audio file and drag it to the audio track in the Timeline window.  

In these cases, using the Timeline window doesn’t really offer any advantage to dragging the 
media files directly to the workspace—it really just provides a different way to work. However, 
the Timeline window does present the fastest way to change your menu background media when 
you use a video file instead of a still-image file. Why? Because when you drag a video file directly 
to the workspace, DVD Architect software adds that file to your project as a separate media file 
instead of as your menu background. 

Try it. Drag a movie file to the workspace. Instead of changing the menu background, this action 
adds the video file to your project as separate media, and adds a link to the menu that enables the 
viewer to navigate to the video file. Click the Undo button to remove the media file and link from 
your project. 

Now, drag the same video file to the Timeline window. This changes the menu background so 
that it now uses the video instead of a still image, and if the video contains audio, adds the audio 
as the menu audio. Notice that you can now drag a different audio file to the timeline window to 
replace the video’s audio with the new file. In the same way, you can drag a still-image file to the 
timeline to replace the video portion of the video with the still image, thus effectively using the 
video’s audio along with an alternative image. 
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Using the Timeline window to work with menus provides a good basis for understanding how 
the window works. But the window reveals its real power when you use it to work with media 
files that you add not as menus, but as featured aspects of the DVD. Now that you have the 
basics of the Timeline window well in hand, let’s take a detailed look at all of the powerful new 
features this window contains. 

Working with a media file 

You may have noticed during our discussion of the basics of the Timeline window that 
most of the buttons at the top of the window remained unavailable to you. That’s all about to 
change as you begin adding media files to your project. Drag a video file from the Explorer 
window onto the workspace. For our discussion, we’ll call that file MediaX. As you’ve already 
seen, this inserts MediaX into your project, and creates a link to it on the menu. Notice that the 
Timeline window still represents the makeup of the menu. 

Right-click the link on the menu for MediaX, and choose Navigate Into from the pop-up menu. 
Notice that the Timeline window now represents MediaX. Notice also that most of the buttons at 
the top of the Timeline window are now active and ready for you to click as shown in Figure 13 

Figure 13 
Once the media is selected, the buttons in the Timeline toolbar become active. 

 

Just as you did a few moments ago when working with the media you used for the menu video 
and audio, you can easily swap the audio track, the video track, or both tracks for MediaX. For 
instance, perhaps you used the Vegas application’s rendering tools to encode MediaX as an 
MPG2 file called MediaX.mpg. You want to use the video portion of that file on your DVD. But 
perhaps you’ve also encoded the audio portion of the MediaX Vegas software file to a 5.1 
surround-sound encoded AC3 file called MediaX.ac3. You add MediaX.mpg to your DVD 
Architect software project. You can now use the Timeline window to easily replace the audio 
track of MediaX.mpg with the MediaX.ac3 file. 
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Setting the in and out points of your video 

One of the most basic adjustments you can make on how your project treats MediaX is to 
change the in and out points for the file. For instance, MediaX may be 5 minutes long, but you 
only want to link to the middle three minutes. The Timeline window provides several ways to 
specify the exact frames at which you want the video to start and end playing, even if those 
frames are not the physical start and end of the file. In other words, you can set the in and out 
points of MediaX to show just the portion you want. 

When you first add a media file to your project, the in and out points of the file match the very 
beginning and very end of the file. The yellow triangles in the time ruler (just above the video 
track) mark the in and out points. Drag the right-most yellow triangle to the left. This creates an 
earlier out point than the end of the media file. Notice as you move the out point, the time 
display (above the track headers) indicates the precise location of the new out point. In the same 
way, drag the left-most triangle to adjust the in point for the media file. You can use all of the 
same zoom techniques that you know from Vegas software to zoom in on the timeline in order to 
make finer adjustments to the in and out points. 

At times it might be easier to find a specific point in your media file by viewing and listening to 
it, and then adjusting the in or out point to match the cursor location. The Timeline navigation 
bar looks very familiar. In fact, it contains the same buttons that you are used to using in the 
Vegas software timeline. Let’s use the transport buttons to help us set a new in point for the 
MediaX file that we added earlier. With MediaX open in the Timeline window, click the Play 
button. The video begins to preview in the workspace. Watch the video for a moment, and then 
click the Pause button in the Timeline window. The cursor stops on the exact frame on which it 
was when you clicked the Pause button. To make this frame your new in point, click the Set In 
Point button. Click the Play button again, and after a moment, click the Pause button again. To 
make this frame your new out point, click the Set Out Point button Figure 14. Notice that when 
you change the in and out points, the Timeline identifies the active area of the file (the area 
between the in and out points that will actually be seen when the viewer follows this link). The 
dark shading before the in point and after the out point indicates that these portions of the media 
file will not be seen or heard. 

Figure 14 

Click the Set In Point and Set Out Point buttons to establish in and out points for the selected media. 

 

Quantize to Frames 

Set Out Point 
 
Set In Point 

 

Finally, you can click to place your cursor at a specific point in the Timeline, use your Right and 
Left arrow keys to scroll through the Timeline to find the desired frame (as in Vegas software, 
hold down the Alt key in combination with the Right and Left arrow keys to limit the cursor 
movement to one frame at a time), or double-click the time display, enter an exact location, and 
press the Enter key to place your cursor at that location. Once you’ve repositioned your cursor 
with one of these methods, you can set your in and out points accordingly as described above. As 
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in Vegas software, you can quantize your cursor movements to video frames. This means that the 
software does not let you place your cursor anywhere other than a precise frame edge. Editing 
your video in the middle of a frame can sometimes cause video glitches, and the quantize feature 
prevents these glitches. To turn quantize to frames on or off, click the Quantize to Frames button. 

Working with DVD chapters 

The Timeline window provides tools for setting, adjusting, importing, removing, and 
saving chapter markers for your video files. These chapter markers can be used to create scene 
selection menus, provide links to exact points in the video, and so on. Every media file has one 
chapter marker by default that corresponds to the in point of the file. You can add as many 
chapter markers as you want. If you added markers in the Vegas application, and saved them 
when you rendered the file, DVD Architect software recognizes those markers as chapter 
markers. Chapter markers appear in the Timeline window above the time ruler. 

You can move the chapter markers to any spot in the media file that you want—even if the 
markers were originally placed in Vegas software. To see this, render a video file from Vegas 
software. Do not embed markers during the render process. Insert the video file (again, let’s call it 
MediaX) into a new DVD Architect project, and double-click the MediaX icon in the workspace to 
navigate into it. MediaX now shows in the Timeline window. 

Assuming that you did not imbed markers into MediaX when you rendered it from Vegas 
software, the Timeline window shows that MediaX has one chapter marker, and as we 
mentioned, that marker corresponds to the in point of the video. Drag the orange marker flag to 
another location in the timeline. Notice that you can place it wherever you want, and that when 
you change the position of Chapter 1, you simultaneously change the in point for MediaX. 
Likewise, you may have noticed earlier that when you change the in point marker in the timeline, 
the Chapter 1 marker moves with it. 

You can use the Timeline window to insert additional chapter markers to MediaX. Use any of the 
cursor placement techniques you know from Vegas software to find the exact frame at which you 
want a new chapter to start. Once you’ve positioned the cursor, click the Insert Chapter button 
shown in Figure 15 to drop a chapter marker at the cursor location. A new marker appears in the 
marker bar, and the software highlights the name of the marker so that you can give it whatever 
label you want to. For now, type “Scene 2” for the marker name, and press the Enter key. You 
can now drag this marker to a new location if you want to change its location. 

Figure 15 
Click the Insert Chapter button to insert a chapter marker at the current cursor location 

 

Insert Chapter 
 

Next, point your mouse to a location in the video thumbnails that’s between the second chapter 
point and the out point of the media file. Double-click at that location. This inserts a chapter 
marker at the double-click location, and again gives you the opportunity to name the chapter. 
Name it “Scene 3.” 
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Now, set the in point of MediaX to a location in the timeline between the second and third 
chapter markers. Notice that DVD Architect software now ignores the marker that falls outside of 
the active area (that is, the old Chapter 2), and renumbers the Scene 3 marker, which still falls 
within the active area. The second active marker still retains the name you gave it, Scene 3, 
although the marker now contains the number 2, so you’ll need to decide whether or not that 
name is still appropriate. Set the in point back to the beginning of MediaX. The Scene 2 marker 
becomes active again, and the marker numbering updates accordingly. 

Once you’ve placed all of the markers you want in the timeline, you can embed those markers 
permanently into the media file. Let’s imbed the three chapter markers we’ve been working with 
into MediaX now. Click the Save Markers button shown in Figure 16.  

Figure 16 
Click the Save Markers button to save markers that you placed in the timeline. 

 

Save Markers Load Markers 

 

Now that MediaX now contains the embedded markers, you can experiment with the chapters in 
the timeline with confidence that you can always go back to the embedded markers if you choose 
to. To see this, insert a few more markers into the timeline. Right-click the chapter you named 
Scene 2, and choose Delete Chapter from the menu. Now, click the Load Markers button. This 
resets the chapter markers back to those that you previously embedded into MediaX. 

Adding additional audio tracks 

Often you may want to add an additional audio track to go along with the video portion 
of your media file. For instance, perhaps you want to include a director’s commentary track, or 
an alternate language track along with the original audio track. You can add up to 8 distinct 
audio tracks to the Timeline window.  

We’ll create a project that you can easily follow along with and will give you a great feel for how 
alternate audio tracks can work. To prepare for creating this project, open up Vegas software, and 
use the Text media generator to create a 10-second countdown in which the first frame of the 
movie shows the number 10 on screen, and each second the number decreases by one until you 
get to the number 1. In preparation for using this file for the discussion of subtitles which follows 
this section, make all of the even numbers white on a black background, and all of the odd 
numbers black on a white background. 

With the video portion of your movie complete, add an audio track, and record yourself counting 
down from 10 in English along with the changing numbers in the video. When you’re done, 
render the project as an MPEG2 file, and call it English.mpg. Now, go back to your project, and 
record yourself counting down in Spanish (Diez, nueve,  ocho, siete, seis, cinco, cuatro, tres, dos 
uno. Don’t worry about pronunciation—no one will ever hear it but you!) This time, render just 
this Spanish audio track as Spanish.wav.  
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Adding a new audio track 

Back in DVD Architect software, start a new project, and insert the file English.mpg to Menu 1 
(Page 1). Right-click the icon for English.mpg, and choose Navigate Into to open the file in the 
Timeline window. Click the Add Audio Track button shown in Figure 17. The Timeline window 
now shows two audio tracks, one of which doesn’t yet contain any audio. Drag the file 
Spanish.wav from the Explorer window to the blank audio track in the Timeline window. 

Figure 17 
Click the Add Audio Track button to add up to 8 additional audio tracks to the timeline. 

 

Add Audio Track 
 

Activating an audio track 

We need to determine which audio track plays by default when the user navigates to this file on 
the final DVD. Notice the different appearances of the Activate Track buttons on the two audio 
tracks in Figure 18. The highlighted state of the Activate Track button for audio track 1 indicates 
that track 1 is currently the active track. Click the Play button in the Timeline window’s 
navigation bar to preview the media file in the workspace. You hear the original English audio 
from audio track 1. 

Figure 18 
Click the Activate Track button to select which audio track is currently active 

  

Activate Track 

Now, click the Activate Track button for audio track 2. (If the file is not still previewing, click the 
Play button again.) You now hear the Spanish audio from audio track 2. The Activate Track 
button not only determines the track you hear on previewing the file, but also the default track 
that plays on the final DVD. Click the Activate Track button for audio track 1 to make that the 
active track again. 

Specifying the track language 

You can assign a track language to each audio track so that the viewer knows which language a 
track contains. For audio track 1, click the Down Arrow portion of the Track Language button 
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and choose English from the drop-down list. This identifies audio track 1 as an English track. Use 
the same method to identify audio track two as a Spanish track. 

If the language you want to use does not appear in the drop-down list, choose Choose Language 
to open the Change Track Language dialog. This dialog contains an extensive list of less common 
languages. Choose the desired language—for example, choose Arabic--from this list and click the 
OK button. Click the Down Arrow on the Track Language button, and notice that Arabic now 
appears on this drop-down list. This illustrates that DVD Architect software updates the list to 
include a language that you have chosen in the past under the assumption that it makes sense 
that you might want to assign the same language to other audio tracks in your project. 

Now that you’ve identified your two tracks with languages, click the Preview button in the main 
DVD Architect software toolbar. As the video plays in the Preview window, click the Audio 
button in the lower-left-hand corner of the virtual remote control device shown in Figure 19. This 
opens the Change Audio Track dialog. In this dialog, you see all of your audio tracks listed, and 
since you left audio track 1 as the active track (if you followed our instructions above), you see 
that track 1 is selected in the Select Audio Track list. Select track 2 (the Spanish track), and click 
the OK button. You now hear the audio from audio track 2 (your Spanish version.) 

Figure 19 
Click the Audio button on the virtual remote control to select an alternate audio track 

 

Select Audio Track 

Now, click the Activate Track button on audio track 2, and click the Preview button again. This 
time the file previews with the audio from audio track 2. You can use the Audio button on the 
virtual remote control device to switch to the other audio track like you did above. 

Deleting a track 

Should you decide you no longer need one of the audio tracks in your Timeline window, right-
click the track header for the track you no longer want, and choose Delete from the pop-up 
menu. You can delete any other track in the timeline in the same way—with two exceptions: The 
video track, and the last remaining audio track. The Timeline window will always contain the 
video track and at least one audio track. If you try to delete either of those tracks, you’ll only clear 
what’s on them—you won’t actually delete the tracks. You’ll see from that same menu that you 
can also cut, copy, and paste audio tracks in the Timeline window. 
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Don’t close your DVD Architect software project. You’ll add subtitles to it in the following 
section. 

Working with Subtitles 

The Timeline window contains several tools for creating, arranging, and working with 
subtitles that can appear on the video screen while your DVD media plays. You can create 
subtitles right inside the Timeline window, or import them from other sources. Let’s start by 
creating subtitles with the tools in the Timeline window. 

Adding a subtitle track 

In the project you started in the previous section, you have a video file that contains English 
narration and an extra track of audio that contains the Spanish translation of that narration. In the 
Timeline window, click the Add Subtitle Track button shown in Figure 20. This adds a new 
subtitle track to the Timeline window. You can add up to 32 subtitle tracks to each media file in 
your project. Add another subtitle track now so that you have two subtitle tracks in your project. 
Use the Track Language button as described in our discussion of audio tracks above to designate 
subtitle track 1 as English, and subtitle track 2 as Spanish.  

Figure 20 
Click the Add Subtitle Track button to add up to 32 subtitle tracks 

 
Add Subtitle Track 

 

Creating subtitles in the Timeline window 

Now let’s create Spanish subtitles to lay over our text when the English version of the audio 
plays. Click the track header for the subtitle track you designated as Spanish (subtitle track 2 if 
you’ve been following our instructions.)  This selects subtitle track 2. Place your cursor at the 
beginning of the file. “10” shows in the video at this point. Click the Insert Subtitle Text Event 
button, shown in Figure 21. This inserts a subtitle text event into Subtitle track 2. Notice the text 
event says simply “Text” when you first add it to the project as you can see in the event as well as 
the Workspace. 

Figure 21 
Click the Insert Subtitle Text Event to insert a text event at the current cursor position 

 
Insert Subtitle Text Event 

 

In the Workspace, right-click the subtitle text box and choose Edit Text from the menu. Now type 
the desired subtitle—“Diez” in this case. You can also change the font, size, attributes (bold, 
italic) and justification of the text just as you have learned to do in version 1. In a moment, we’ll 
show you how to add an outline to your subtitles, and later when we talk about the Properties 
window, we’ll show you how to change the color of your subtitles. 
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For now leave all of the text attributes as they are. Go back to the Timeline window, and click the 
Play From in Point button. As the movie plays in the Workspace, you notice that your subtitle for 
the number 10 lasts far too long. You can trim the subtitle event just like you trim events in Vegas 
software. First click in the timeline near the transition between the numbers 10 and 9. Look at the 
waveform in the English audio track to help you get close. Hold down the Alt key and Press the 
Right or Left Arrow key until you find the exact frame where the number changes from 10 to 9. 
Now, drag the right edge of the subtitle event to the left until it snaps to the cursor. Play the file 
again and notice that the subtitle now disappears when it should. 

Right-click the subtitle event, and choose Copy from the menu. Click the right edge of the event 
to place the cursor there, then right click at the cursor and choose Paste from the menu. You now 
have a second subtitle event in the right spot for the number nine. In the Workspace, edit the 
subtitle so that it says, “Nueve.”  

You might find it difficult to read the subtitle “Nueve” since it is white text against a white 
background. It’d be easier to read if it were against a black background. With the subtitle event 
selected, notice that the Outline button is active in the text tools bar. Click the Outline button, 
shown in Figure 22  to turn the outlining off. Now instead of outlining the text, the outline color 
fills the text box.  

Figure 22 
Click the Outline button to toggle between outline and colored text box 

 
Outline 

Continue adding subtitles until you have all of the Spanish subtitles in place. Preview your movie 
to see how it looks with your new subtitles.  

Updating subtitle attributes 

Based on what you see when you preview the movie with subtitles, you might decide to change 
the attributes of your subtitle text. For instance, perhaps you want a large font size and a different 
font face. Let’s change those attributes of the subtitle event Diez to make it easier to read. In the 
timeline, click the Diez subtitle event. In the Workspace, right-click the word Diez and choose 
Edit Text from the menu. Change the font to 26-point Impact and turn off the outline. 

In the Timeline window, click the Activate Track button (shown in Figure 23) for the Spanish 
subtitle track, then click the Play From In Point button to preview the movie with the Spanish 
subtitles. You can see the change you made to the Diez subtitle event, but all of the remaining 
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events still have their original characteristics. It could take a long time to go through your project 
and make these same changes to every subtitle event individually, but DVD Architect software 
makes the task quick and simple. 

Figure 23 
Click the Active Track button in the subtitle track header to designate the active subtitle track. 

 

Active Track 

Select all of the Spanish subtitle events in the timeline (including the Diez event.) Right-click on 
the Diez subtitle event and choose Apply Formatting to Selected Events from the menu. This 
instantly updates all of the selected events so that the formatting of their text matches the 
formatting of the Diez event. Click the Play From In Point button to see that all of the Spanish 
subtitles have been updated with the same font formatting as the Diez event.  

Now let’s create English subtitles to go along with the Spanish audio. You might find it helpful if 
the English subtitle track and the Spanish audio track were adjacent to the video track so you can 
easily see them all at one glance. Use the same techniques you use in Vegas software to reorder 
the tracks as you want them. For instance, drag the track header icon for subtitle track 1 and drop 
it between the video track and subtitle track 2. This moves the English subtitle track to the second 
subtitle track position. In the same way, move the Spanish audio track so that it sits just below 
the video track. Figure 24 shows how this arrangement looks. 

Figure 24 
Drag the track headers to reorder the tracks. 

 

Make sure to activate both the English subtitle track and the Spanish audio track. Click the Play 
button in the Timeline window. You should hear your Spanish countdown, and should not see 
any subtitles (since you haven’t added your English subtitles yet.)  Now use the same techniques 
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we described above to create English subtitles. Format the English subtitles with 60 point, Comic 
Sans MS text, and no outline. 

Now your English subtitles don’t have the same font attributes as your Spanish subtitles, but you 
can easily fix this difference. Click the track header icon of the English track to select it. Hold 
down the Ctrl key, and click the track header for the Spanish subtitle track to add that track to the 
selection. Right-click the Ten subtitle event in the English subtitle track and choose Apply 
Formatting to Selected Tracks from the menu. This applies the formatting of the Ten subtitle 
event to all events on both the English and the Spanish subtitle tracks. 

Now, click the Preview button in the main toolbar to preview your DVD. Use the Audio and 
Subtitle buttons at the bottom of the virtual remote control to switch back and forth between 
English and Spanish audio tracks, and the two different subtitle tracks. 

Editing subtitle events with ripple editing 

You can use many of the same editing techniques that you use to edit events in the Vegas 
software timeline to edit subtitle events in the DVD Architect software Timeline window. For 
instance, you can drag an event to a new location, or trim an event to make it longer or shorter. 
Let’s say that event Eight in your English subtitle track doesn’t last long enough. Point to the 
right edge of the event. Your cursor changes into the familiar trim icon that you get when you 
point to an event edge in Vegas software. 

Now drag the event edge to the right to make the event last longer. Notice that as you do, events 
that occur later in the timeline move to make room for the larger event Eight. This ripple editing 
feature works much the same as it does when you execute a post-edit ripple to the affected tracks 
in Vegas software. 

Click the Auto Ripple button (shown in Figure 25) to turn ripple edits off. Now trim the right 
edge of the Eight event to the left to make the event shorter again. Because you turned auto ripple 
feature off, this leaves a hole in your timeline because the other events do not move along with 
your edit. Click the Undo button to undo the last trim move on event Eight. Click the Auto 
Ripple button to turn that feature back on. Finally, trim the right edge of event Eight to the left 
again to make it shorter. This time, the other events move to close up the hole since you turned 
auto ripple back on. 

Figure 25 
Click the Auto Ripple button to toggle on and off the auto ripple feature. 

 
Import Subtitles 

 
Auto Ripple Export Subtitles 

Exporting subtitles 

Once you’ve got your subtitles in place, you can export them to a text file. This makes it easy to 
create a text document that you can send to a translator if you need alternate language versions 
of the same subtitles. For instance, let’s say we just finished the example we worked through 
above except that you don’t know how to count down from 10 in Spanish. To follow through 
with this example, click on the first event in the Spanish subtitle track to select it. Now, hold 
down the Shift key and click on the last event. This selects the first and last events, as well as 
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every event between them. Now right-click any of the selected events and choose Delete from the 
menu to delete all of the selected events. 

Click on the track header icon for the English subtitle track to select that track. Click the Export 
Subtitles button. Choose your My Documents folder as the save location and name the file 
CountdownSubtitles_English. From the Save as type drop-down list, choose Sony Vegas Region 
List. Click the Save button. You’ve just saved your English subtitles into a text document. Open 
the new text document in Notepad. 

You can see in Figure 26 that the text document contains four columns. The first column gives 
you the start time of each subtitle event (each row shows a separate event.) The second column 
gives you the end time of the event, and the third column gives you the total duration of the 
event. The fourth column is the one you want your translator to work on—it contains the text of 
the subtitles. Send a copy of this text file to your translator, and have them change the text in each 
row of column four to the Spanish translation as shown in Figure 27. Have them save the file as a 
new text file called CountdownSubtitles_Spanish. 

Figure 26 
Save the file as a Sony Vegas Region List and open it in Notepad 

 

Figure 27 
Translated version of Coundown-Subtitle.txt document 

 

Importing subtitles 

Now that you’ve received your translated subtitle text back from your translator, you can quickly 
import it into your DVD project. Click on the Spanish subtitle track to select it. Click the Import 
Subtitles button. Navigate to the file CountdownSubtitles_Spanish.txt and click Open. DVD 
Architect software instantly imports the translated subtitles into your project. Since the file you 
imported had all of the in and out information for each subtitle, the subtitle events already match 
the movie’s timing perfectly. Preview the Spanish subtitles to see the results. 

As you learned if you’ve already read through the New Features Series document for Vegas 5 
software, you can export subtitles from Vegas software and import them into your DVD project. 
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Recall that in the Vegas application you created a small video project, and from that project you 
exported two subtitle documents, which you called English.sub and Spanish.sub. If you followed 
our instructions, you saved all of these documents to My Documents | Subtitle Example. You 
also rendered an MPEG2 version of the movie, which you called SubtitleExample.mpg. Let’s add 
that movie to our DVD and import the subtitles that go along with it. 

In the Project Overview window, navigate back to Menu 1 (Page 1). In the Explorer window, 
navigate to My Documents | Subtitle Example and drag the file SubtitleExample.mpg onto 
Menu 1. Double-click the SubtitleExample link to navigate into it and open it in the Timeline 
window. 

In the Timeline window, click the Add Subtitle Track button two times. Use the Track Language 
drop-down list to designate the first subtitle track as English. Designate the second subtitle track 
as Spanish. 

Click the track header icon for the English track and then click the Import Subtitles button. 
Navigate to My Documents | Subtitle Example and choose the English.sub file. Click Open to 
import that file. Use the same method to import Spanish.sub into the Spanish subtitle track. 

Now click the Preview button in the main toolbar to view the movie. Use the Subtitle button in 
the lower-right-hand corner of the virtual remote control to choose which language you want to 
see for your subtitles. As you can see, since Vegas software exported not only the subtitle text, 
but also the in and out information for each subtitle, the timing of the subtitles works perfectly 
with the video that you rendered from the Vegas application. 

As a shortcut for importing subtitles, you can also drag a text file from the Explorer window to a 
subtitle track in the Timeline window. DVD Architect software imports the subtitles and places 
them in the proper positions according to the timecode in, timecode out, and subtitle event 
duration. 

Creating viewer controls for subtitles and alternate audio tracks 

Usually when you provide subtitles and alternate audio tracks, you’ll want to build into the DVD 
interface a way for the viewer to choose which language they want to listen to and read as 
subtitles. You can easily create buttons in DVD Architect software that give your viewers this 
ability. We’ll show you how to do that later in this document when we talk about the Properties 
window. 
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VI: The Compilation window 
As in version 1, you can create both picture and music compilations with DVD Architect 2 
software. The techniques for doing so remain essentially the same. Enhancements in the new 
version make the process more intuitive and easier. In this section, we’ll explore the new 
Compilation window and learn how to use it in creating your picture and music compilations. 

Creating picture compilations 

To create a picture compilation, start a new project and click on the Compilation tab as 
shown in Figure 28. If you can’t find the Compilation tab, the Compilation window may be 
closed. Choose View | Compilation to open it. At this point, the Compilation window doesn’t 
offer much to look at, does it? Let’s change that now. 

Figure 28 
In its default location, you’ll find the Compilation window in the upper-right corner of the interface docked under the Properties 
window. 

 

Choose Insert | Picture Compilation to add a picture compilation link (Picture Compilation 1) to 
your menu. The link does not contain any graphic, so for now, let’s give it a button style. With the 
link button selected, click the Buttons tab. In the Buttons window, click on a button thumbnail 
that has a distinct boarder, and click the Replace Button button.  

In the Workspace, right-click the link button and choose Navigate Into from the menu. The 
Compilation window now changes to familiar territory. It looks just like the compilation interface 
in version 1, and works in essentially the same way too.  

To assemble your picture compilation, use the Explorer window to navigate to still images on 
your computer system. Select one or more pictures, and drag them into the Compilation window. 
From here on, use the same techniques you used in version 1 to arrange the pictures in the exact 
order you want, assign specific times to each picture, adjust the orientation of individual pictures, 
fit the compilation to the duration of the music, and so on. 

Notice that version 2 does not automatically add a textbox with the file name in it to each 
individual slide. You can still add a text box manually if you want to. 

Another difference involves adding audio to your compilation. To add audio that plays while 
your picture compilation plays, drag an audio file from the Explorer window onto the audio 
track in the Timeline window. 
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You can also use the Timeline window to add subtitles to your picture compilation. 

Creating music compilations 

Music compilations represent familiar territory too. As with picture compilations, you 
know most of what you need to know already from your work in version 1. Let’s walk through it 
quickly and point out any areas of difference. 

Assuming that you followed our instructions above for creating a picture compilation, the picture 
compilation is still loaded into the compilation window. In the Project Overview window, 
double-click the icon for Menu 1 (Page) to navigate back to that menu. Choose Insert | Music 
Compilation to insert a link to a new music compilation. You may need to drag the link to a new 
location on the menu so that it doesn’t overlap the existing picture compilation. Add a button 
frame to the link as you did with the picture compilation. (By the way, note that now the picture 
compilation link button contains a graphic. This is simply the first graphic in your compilation.) 

Double-click the music compilation link button to navigate into it. Again, you’re on familiar 
ground, and things work very much like version 1 at this point. Navigate to music files in the 
Explorer window, and drag the ones you want to include in your music compilation into the 
Compilation window. You can use the techniques you already know from version 1 to add 
images to play while each song plays. You can also add video files to your compilation to show 
the video as the audio plays. 

Again, notice that DVD Architect no longer adds the name of the file to the image automatically. 
You can manually insert a text box and place it anywhere in the workspace that you want. 

As with picture compilations, you can use the Timeline window to add subtitles to your music 
compilation (which is great for printing song lyrics on screen!) 
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VII: The Properties Window 
The Properties window contains many of the functions that the Properties area did in version 1. 
But the window also opens up a world of new possibilities in DVD Architect 2 software. Among 
the most exciting new features the Properties window makes possible are assignable end actions, 
color sets, and button masks. And there’s much more. In this section we’ll explore the new 
Properties window in detail. 

Finding your way around the Properties window 

The Properties window presents a wide variety of parameter controls that relate to many 
different objects and functions that you use in creating your DVDs. It uses a hierarchical structure 
similar to that of the Explorer and Project Overview windows (although presented slightly 
differently) to organize the parameter controls it contains. To see how it works, let’s start with a 
brand new project. As with every new project, DVD Architect 2 software inserts the first menu 
for you automatically. At this point, the properties window contains many property-setting 
controls. However, you’ll see throughout the course of this topic that it does not yet contain 
everything that it potentially can. 

What the Properties window contains depends upon what object you select or into which you 
navigate. In other words, the Properties window’s content changes in order to present you with 
just the controls that relate to the object on which you’re currently working. It is extremely 
important to remember this point so that you don’t get confused about what your viewing in the 
window. For instance, when you’re working on your menu page properties, make sure that you 
don’t have any of your interface buttons selected since selecting buttons opens up additional 
properties related to the selected button. 

Since your project is brand new, it contains only one menu. Thus, the Properties window 
currently contains two major headings: Menu Page Properties and Color Sets. You can identify 
major headings like these in a couple of ways. First, the major heading names are presented over 
a light blue to white gradated tint. Also, notice the indentation structure of the window contents. 
The major headings are not indented, while subheadings are. Certain subheadings have 
subheadings of their own which are further indented.  

When a heading contains subheadings, click the plus or minus sign in front of it to expand or 
collapse the subheadings. Try it now. Click the Minus sign (-) in front of the headings Menu 
Page Properties and Color Sets. This collapses the information in the list down to these major 
headings. For now, click the Plus sign (+) in front of the Color Sets heading to expand it so that 
we can discuss color sets in the following section. 

Understanding Color Sets 

Color sets provide a versatile and fully customizable method for choosing the colors of 
certain objects in your project—namely button highlights and subtitle text outlines and 
backgrounds. You have four color sets to work with on every menu in your project, and each set 
contains four colors. DVD Architect 2 software designates each of the four colors in a set for a 
specific aspect of the object to which you assign the set. The four aspects that make up a color set 
include: 

• Fill color—used for the highlight color on menu buttons and the color of subtitle text. 

• Outline/background color—used for the background or outline color of buttons and 
subtitle text. 
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• Anti-alias color—helps smooth the edges of menu button highlighting and subtitle text 
against the outline/background color. Typically you want this to be a blend or average of 
the fill color and the outline/background color.  

• Transparent color—specifies transparent portions of subtitle text events and menu button 
highlighting. For instance, if you set your transparent color to red, you are essentially 
telling the software to treat any red areas as if they are transparent.  

Each of the four color sets on a menu can be custom or project-wide. You can specify four project-
wide color sets, and then use the project-wide color sets for any menu in your project. This is a 
good way to create consistency across menus. However, you can also choose to use up to four 
custom color sets on each menu. Custom color sets override the project-wide color sets for just 
the object to which you apply the set. If you use custom color sets on each menu, then you can 
make each menu’s color sets different from every other menu’s color sets. 

By default, DVD Architect software assigns each of the four color sets to specific purposes for 
each new menu you open. Color Set 1 controls the color of button highlights for buttons in their 
selected state. Color Set 2 controls the color of button highlights for buttons in their activated 
state. Color Set 3 controls the color of button highlights for buttons in their inactive state. Color 
Set 4 controls the color of your subtitle text events. We’ll explore each of these later. Although 
what we’ve just described is the default behavior, you’ll see later that you can change it if you 
want to. 

Click the Minus Sign (-) for any expanded color set so that you see only the subheadings for the 
four color sets. To the right of the label of the color set (for example, to the right of the label Color 
Set 1), a field identifies the color set as either Custom or Project wide. Notice that until you make 
any changes, Color Sets 1 and 2 use custom settings, while Color Sets 3 and 4 use project-wide 
color settings. As mentioned, you can change any of the color sets to be either custom or project-
wide. Click the label for Color Set 2.  A drop-down arrow appears at the right side of the current 
property setting. Click the drop-down arrow, and choose Project wide from the drop-down list. 
You have just specified that Color Set 2 will now use the project-wide settings instead of the 
custom set.  

You can also change the colors of each color set. For instance, let’s change the fill color of each of 
the first three color sets. First, click the Plus Sign (+) in front of Color Set 1 to expand it. Then, 
click the color box next to the fill color label. Now click the drop-down arrow at the right edge of 
the color bar to access the color chooser. The color chooser is familiar to you from working in 
both Vegas software and version 1 of DVD Architect software. Specify the color R=0, G=0, B=255, 
and set the alpha channel (the A field) to 255. Press the Enter key to lock these settings in. This 
specifies a completely opaque dark blue for the fill color of Color set 1. Now set the fill color for 
Color Set 2 to R=0, G=255, B=0, and A=255 (which creates a completely opaque green.) Finally, 
set the fill color for Color Set 3 to R=255, G=0, B=0, A=255 (a completely opaque red.)   

You could change all of the colors in each color set in the same way. For now, let’s leave all of the 
other colors as they are. We’ll move on to a discussion of Menu Page properties, and during the 
course of that discussion, you’ll have the opportunity to see how the changes you made here 
affect your project. 

Setting your Menu Page properties 

Each menu in your project contains its own set of properties. These appear in the 
Properties window under the Menu Page Properties heading. Click the Minus Sign (-) next to the 
Color Sets heading to collapse that heading completely. Click the Plus Sign (+) next to the Menu 
Page Properties heading to expand it. Some of the properties in this window will be familiar to 
you from your experience in version 1, although they are presented differently here. Other 
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properties here introduce some of the most exciting new features of version 2 including 
assignable end actions and masking techniques.  

Background media 

The first menu page property, Background media, gives you options for how you want to deal 
with a graphic that you’ve assigned to be the background of your menu when that graphic’s pixel 
aspect ratio does not match the aspect ratio of the workspace. This property consists of the same 
three choices that were available in version 1—Letterbox, Zoom to fit, and Stretch to fit—and 
those options treat the graphic the same way they did in the earlier version. 

Unless you changed it since you started the new project, the Background media property is set to 
Stretch to fit. Choose Letterbox from the Background media drop-down list, and notice that now 
the background image does not fill the entire Workspace. Change the property setting back to 
Stretch to fit. 

By the way, now that you know where to find the drop-down list to change each property’s 
setting, you can save yourself a click. Instead of first clicking on the property label, click at the 
right edge of the property setting—where you know the drop-down arrow is—to open the drop-
down list immediately. This works for all properties. 

Menu length 

The Menu Length setting has more relevance when you add a video file as your menu 
background as opposed to a still image. This property also works just as it did in version 1. You 
still have two choices here: You can let the software calculate the menu length for you based on 
the length of the video file (the Auto calculate option), or you can specify a menu length (the 
Specify option), thus overriding the file length. 

Length 

If you set the Menu Length property to Specify, the Length property becomes editable. You can 
type a specific length (in Hours:Minutes:Seconds.frames) into the Length property field, or you 
can click the drop-down arrow. This property introduces a new control. In this case, the drop-
down arrow uncovers a slider that you use to specify the length of the menu. Drag the slider 
right to increase the length and left to decrease it. You’ll see this slider control on many other 
properties as well. 

Selected button colors 

Here’s where what you learned about color sets earlier comes into play. The Selected button 
colors property determines the color highlight to be used when the viewer navigates to and 
selects a button on this menu of the DVD interface. 

Click the New Project button to start a new project. From the Buttons window, drag two framed 
buttons to the workspace. Click the Preview button. Notice that a highlight identifies the 
currently selected button. Use the virtual remote control device to select the other button and 
notice that the highlight changes accordingly. 

This highlight is determined by the Color set chosen in the Selected button colors property, which 
by default uses Color Set 1. You can set this property to use any—or none—of the four color sets 
you’ve define for this menu page. If you want to change which color set you use for the selected 
button colors, first make sure that neither of the buttons that you added to your menu is selected 
(you can click on the menu background image to deselect a selected button), and choose a 
different color set from the Selected button colors drop-down list in the Properties window. 

For now, instead of choosing a different color set, let’s modify the one we’re already using (Color 
set 1) to see how you can affect the look of your button highlights. In the Properties window, 
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expand the Color Sets heading if it’s not already expanded, then expand the Color Set 1 
subheading. Click the color bar for the fill color to access the color picker. Change the color 
assigned to the fill color to R=255, G=0, B=0, A=255.  

Click the Preview button. You can easily see how the highlight has been changed by the new 
settings you entered for the fill color of Color Set 1. Close the Preview window. 

In the Project Overview window, right-click the Menu 1 folder and choose Insert | Menu Page 
from the menu. Add two buttons to the new menu page—Menu 1 (Page 2), and then preview that 
menu page. You can see that since this is another page of Menu 1, the highlighting that you set 
for Menu 1 (Page 1) applies to this page too. You could change the Menu 1 (Page 2) color set 
settings if you wanted page 2 to be different than page 1 for some reason. 

Back in the Project Overview window, right-click the Menu 1 (Page 1) icon and choose Insert | 
Submenu from the menu. Add a couple of buttons to the new submenu and preview the 
submenu. The submenu does not inherit the color settings of its parent menu.  

Activated button colors 

The Activated button colors property enables you to specify the color of the highlight used on a 
button when the user navigates into it. You can think of it as the button’s click state color. Again, 
you can assign any, or none, of the four color sets to handle this. By default, new menus use 
Color Set 2 for this purpose. You can also modify the individual colors within the color set as you 
did above with the color set that the Selected button colors property uses. 

Inactive button colors 

The Inactive button colors property enables you to specify the color of the highlight used on a 
button that has not been selected. In other words, this is the highlight used on a button that is 
“just sitting there” waiting to be selected. By default, this property is set to None (all transparent) 
so that inactive buttons don’t contain any highlighting at all. You can, of course, assign any of the 
color sets to this property. If you decided to do so, Color Set 3 is the one that is intended for this 
purpose. 

Background Media | Video 

The Background Media property has several subproperties that enable you to control the media 
that you use to make up the background of the current menu. You know from version 1 as well 
as from earlier sections of this paper that you can change the file that you use for the background 
on menu pages. The Video subproperty lists the name of the file currently assigned to the video 
portion of the menu background. You saw earlier how you can use the Timeline window to 
change the background image. You can also change the image from inside the Properties window 
with the Video subproperty. 
 
To change the background video image, click the drop-down arrow for this property, click the 
Change Filename button (shown in Figure 29), and search your computer drives for the file you 
want to use. If you don’t want any background image, click the Clear Filename button to delete 
the current background image. 
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Figure 29 
Click the Change Filename button in the Video field to browse to and select a still or motion file to be used as the background for 
the currently selected menu. 

 

Change File Name 

Background Media | Audio 

You also know from version 1 that you can assign background audio to a menu. In version 2, you 
can do so in the Timeline window, or you can do so here with the Audio subproperty. Again, use 
the Change Filename button so select the audio file you want to use as the audio portion of the 
background for the current menu, or click the Clear Filename to remove the current audio file. 

Background Media | Highlight mask 

With DVD Architect 2 software, you have powerful new masking techniques that you can use to 
customize the look and behavior of your interface. Later in this document you’ll learn how to 
create masks, and how to use them in your projects. For now, we’ll mention that once you have 
created a mask, you use the Highlight mask property to apply the mask to your menu. Click the 
drop-down arrow and click the Change Filename button to navigate to the mask file that you 
want to use for this menu. 

Background Media | Highlight mask mapping 

Again, you’ll learn all about masking later in this document. When you do, you’ll learn all about 
the three mask mapping options available in this property. After you know how to use them and 
which option you want to use, click the drop-down arrow for the Highlight mask mapping 
property and choose the desired option from the list.  

End Action 

The End Action property is one of the most powerful and exciting new features of DVD Architect 
2 software. End actions make it possible for you to direct the viewer’s viewing experience. You 
already learned how to use the DVD Start Item to determine what the viewer sees when they first 
start your DVD. With end actions, you can dictate what they do next as well. The End Action 
property of the Menu Page properties has three subproperties. The following table discusses each 
of these. 

• Command—This property determines what you want the DVD to do when the viewer 
reaches this menu. Choose Loop from the drop-down list to create a menu that restarts 
from the beginning when it reaches the end, and continues to play in an endless loop 
until the viewer navigates into one of the links on the menu. You might want to use this 
option when you use a video for your background media. 
 

 

40



DVD Architect 2 learn to use the new features 

Choose Hold to create a menu in which the background media plays once and then stops 
to wait for the viewer to navigate into one of the links on the menu. 
 
Choose Activate Button to create a menu that plays the background media once, then 
waits for a specified amount of time. Once the specified time elapses, the DVD 
automatically navigates into a specified link. This might be great for something like a 
self-running kiosk presentation in which you want to give the viewer time to choose a 
link into which to navigate, but automatically navigate into a predetermined link after a 
certain amount of inactivity. 

• Timeout—Use this property to specify the length of time the DVD should wait before it 
navigates into the predetermined link when you choose the Activate Button option for 
the Command property as discussed above. Specify the desired timeout time in 
“Hours:Minutes:Seconds:Frames” format. This property is only relevant to the Activate 
Button scenario, and is thus not active unless you’ve chosen that option. 

• Button—Use this property to specify the button into which the DVD should 
automatically navigate after waiting for the timeout time that you specified in the 
Timeout property. The options available in the drop-down list for this property depend 
completely on the makeup of your DVD. The option Broken Button printed in red ink 
means that you haven’t yet chosen the button into which you want to navigate. All of the 
buttons you’ve added to your project that lead to other menus and menu pages, 
compilations, and media in your file appear as options in the drop-down list. This 
property is only relevant to the Activate Button scenario, and is thus not active unless 
you’ve chosen that option.  

Remote Buttons 

You can use the Remote Buttons property to dictate which buttons on the viewer’s remote control 
device will be operational when they view your DVD. There may be times when you want to 
restrict the viewer’s ability to access all of the functionality supplied by his or her remote. For 
example, you may want to disable the viewer’s ability to use the remote to navigate away from a 
menu before the background media on the menu has finished playing.  

There are many subproperties under the Remote Buttons property. Each of these subproperties 
represents a button on the typical remote control device. Choose Yes for each property to activate 
the remote button that relates to the property. Choose No to disable the button that relates to the 
property. 

Most of the subproperties in this section are self-explanatory. If you aren’t sure exactly what a 
subproperty in this section controls, the DVD Architect software’s Online Help files provide an 
excellent description of all of the choices. To access the help files, choose Help | Contents and 
Index. Click the Contents tab. Double-click the Using DVD Architect Software entry. Double-
click the Menu-Based DVDs entry. Click the Editing Menu Page Properties entry. In the right-
hand of the Online Help window, click Edit Remote control button behavior, and scroll down to 
see the complete list. 

Setting General Object properties 

The general object properties enable you to view and adjust the size and positioning of 
the selected object on your workspace. The General Object Properties category appears in the 
Properties window only when you select an object such as a button, graphic, or text box in the 
workspace. 

Start a new project. As usual, the new project already has a menu—Menu 1 (Page 1)—and that 
menu contains a text box at the top. In the Properties window, click the Minus Sign (-) in front of 
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both Menu Page properties and Color Sets to collapse those property categories. Notice that those 
are currently the only two properties categories that appear in the window. Now, click the Menu 
1 text box to select it. The General Object Properties category now appears in the Properties 
window. As with other categories, click the Plus Sign (+) and Minus Sign (-) to expand and 
collapse the General Object Properties list. 

X position 

The X Position property shows you the X coordinate of the center of the bounding box that 
contains the object—in other words, how far to the right of the left edge of the Workspace the 
center of the object sits. Drag the text box to the right and notice that when you let go of the 
mouse button the X Position value increases to reflect the box’s new position. Naturally, the X 
Position value decreases when you reposition the box farther left. You can also enter precise 
values into the text field for this property, or click the drop-down arrow, and use the slider to 
choose a new value. Click on the X Position value to select it, and type in 360, then press the 
Enter key to change the X coordinate to 360 pixels from the left edge of the Workspace. This puts 
the text box back into the center of the Workspace (horizontally speaking.) 

Y position 

The Y Position property shows you the Y coordinate of the center of the bounding box that 
contains the object—in other words, how far down from the top edge of the Workspace the center 
of the object sits. Just as when adjusting the X position, you can drag the box up and down, type a 
specific value, or use the slider to adjust the Y position. Use the slider now to adjust the Y 
position to approximately 120. The text box is now centered both left and right (the X position) 
and up and down (the Y position) inside the Workspace. 

X size 

The X size property shows you the width of the selected object. You can enter a specific value or 
use the slider to adjust the X size. Notice that this adjusts the bounding box of the object. For 
instance, drag the slider to the right and notice that the width of the box changes, but the width of 
the text within the box remains the same. Only when you make the box too small to hold the 
object does the object itself actually change size. For instance, drag the slider to the left. The box 
becomes narrower, but the text itself remains the same size until the box becomes too small to 
hold the text at its present size. When it does, the text shrinks to fit inside the box. 

Y size 

The Y size property shows you the height of the selected object. As with the X size, adjustments 
that you make here only affect the size of the bounding box unless you make the box too small to 
fit the object that it holds, in which case, the size of the object itself changes too. To increase the 
height of the box, use a higher Y size value. To decrease it, use a smaller value. 

Maintain aspect ratio 

In working with the X and Y sizes in our discussion above, you saw that the adjustments you 
made do not affect the object in the bounding box unless you make the bounding box too small to 
hold the object at its present size. This behavior stems from the fact that the Maintain aspect ratio 
property is set to Yes. Set this property to No. Now change the X and Y size properties of the text 
box and notice that now any changes you make adjust the size of not only the box, but also of the 
object that the box contains. In this way, you can distort the object. For instance, increase the X 
size only, and you stretch the text right and left. Now increase the Y size only, and you stretch the 
text up and down.  

Click the Minus Sign (-) next to the General Object Properties heading to collapse that section. 
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Assigning button properties 

Buttons introduce a number of new properties that appear in the Properties window. 
Start a new project, and drag a button from the Button window to the Workspace. When you do, 
the button remains selected in your project. Notice in the Properties window that in addition to 
the Color Sets, Menu Page, and General Object properties headings, you now have an additional 
heading: Button Properties. The Button Properties heading contains several subheadings, all of 
which we discuss in this section. 

Action | Command 

The properties listed under this subheading control what happens when the viewer navigates 
into the button. The first option, Link, enables you to create a button that navigates to a specific 
menu, compilation, or media file.  

You can also create buttons that will halt playback of the DVD (choose Stop), or resume playback 
of a stopped DVD (choose Resume.) 

Let’s create a button that links to another menu. In the Project Overview window, right-click the 
icon for the DVD (the one that looks like a disc) and choose Insert Menu from the menu. This 
adds Menu 2 (Page 1) to your project. Now, double-click the Menu 1 (Page 1) icon to navigate to 
Menu 1. Click on the button you added earlier to select it. In the Properties window, set the 
Command property under the Action subheading to Link. 

Action | Destination 

The Destination property specifies where the button leads when the viewer navigates into it. At 
the moment, it probably says in red ink, “Broken Link” because you haven’t yet specified a 
destination for the button. Notice that the drop-down list for the Destination property contains 
several options. These are pretty self-explanatory. Choose Menu 2 from the drop-down list. Note 
that every menu, menu page, submenu, compilation, and media file in your project appears in 
this list. This allows you to create a navigation button to any object in your project. Name the 
button on Menu 1 of your project, “Menu 2.” 

Click the Preview button to test your new navigation button. On Menu 1, navigate into the Menu 
2 button. This takes you to Menu 2 of your project. 

Choose Stop from the Link property drop-down. Notice that the Destination property is not 
applicable (N/A) because stop property simply creates a button that stops playback of the DVD. 

Choose Resume from the Link property drop-down. The Destination property now lists any 
media files you have in your project. This enables you to specify the movie with which the DVD 
should resume playback upon navigation into this button. 

Action | Destination Chapter 

The Destination Chapter property enables you to get very specific with just where you want the 
button to lead. Use the Project Overview window to navigate to Menu 2. Click the Insert Media 
button, and add a video file to Menu 2. If the media file you added does not contain chapters, 
navigate into the media file, and use the Timeline window to add a few chapters to the file. Now 
navigate back to Menu 1. Set the Destination property for the button on Menu 1 so that it points 
to the video file you just added on Menu 2. From the Destination Chapter drop-down, choose one 
of the chapters that you added to your media file. Preview the project, and notice how the button 
on Menu 1 now navigates into the video file at the exact point of the chapter you specified in the 
Destination Chapter property. 

The Destination Chapter property also works when you’re linking to compilations. 

 

43



DVD Architect 2 learn to use the new features 

Action | Destination Button 

The Destination Button property gives you control over which button on a menu will be 
highlighted when you navigate to that menu using the button for which you’re setting properties. 
To see how this works, add another button to the right of the button already on Menu 2, and set 
its Destination property to Menu 1. Navigate back to Menu 1, and set the Destination property 
for the button there to navigate to Menu 2.  

Notice that by default the Destination Button property for the button on Menu 1 is set to Default. 
Preview the project, and navigate into the button on Menu 1. It takes you to menu 2, and you see 
that the first button on the menu (the one nearest the top left of the menu) is highlighted. Close 
the Preview window.  

Now change the Destination Button property for the button on Menu 1 to 2: Link – Menu 1 (Page 
1). Preview the project, and navigate into the button on Menu 1. Notice that this time the button 
that you created that links back to Menu 1 is highlighted when you come to Menu 2. 

Action | Set Audio Stream 

This property enables you to build a button that the viewer can use to choose an alternate audio 
stream through a button on the DVD interface. Navigate into the media file that you added to 
your project earlier. In the Timeline window, add an alternate audio track to that media. 
Designate the original track as one language (perhaps English), and the new audio track as 
another (perhaps German.) Set the Destination property for the button on Menu 1 to play the 
media file. Make sure that the original audio track is the activated track, and preview the project. 
Navigate into the media file, and notice that it plays the original audio track. 

Now change the Set Audio Stream property for the button on Menu 1 to the alternate audio track 
(German in our example.) Preview the project, and navigate into the button on Menu 1. This time 
the media file plays with the alternate audio track. 

Action | Set Subtitle Stream 

The Set Subtitle Stream property works in exactly the same way as the Set Audio Stream property 
that we discussed in the previous section. It enables you to build a button that the viewer can use 
to turn subtitles off (choose the Off option) or to choose a specific subtitle stream (choose the 
number that corresponds to the stream you want the button to activate. This has the effect of 
turning subtitles on and simultaneously activating the specified stream.) 

Graphics | Button Style 

Start a new project. In the Buttons window, click the Show Framed Buttons button and select 
Corporate 2 from the Button Source drop-down. Drag the button from the Button window onto 
your menu, as shown in Figure 30.  
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Figure 30 
Drag the Corporate 2 framed button onto the interface. 

 

Just as in version 1, buttons can consist of just text, just an image, or both. The Button style 
property enables you to specify the type of button you want. For the button you just added, click 
the drop-down arrow for the Button style property, and choose Image only from the drop-down 
list. 

Graphics | Thumbnail 

 If you choose Text and Image or Image from the Button Style property, you’re likely to want the 
button to contain an image that represents the object to which the button links. Use the 
Thumbnail property to specify which image to use. Click the drop-down arrow for the 
Thumbnail property. Click the Change Filename button. This brings up the Open Media dialog. 
Browse to a file that you want to use as the thumbnail image for your button (for now, choose a 
still-image file.) Notice that the file now appears inside the button as shown in Figure 31. 

Figure 31 
The file chosen in the Graphics | Thumbnail field is used as the thumbnail image in the selected button. 
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Right-click the button and choose Copy from the menu. Right-click the button again and choose 
Paste from the menu. You’ve just created an exact duplicate of the button. Click on the second 
button to select it and bring its button properties into the Properties window. In the Graphics 
section, click the drop-down arrow for the Thumbnail property. Click the Clear Filename button 
to remove the thumbnail image from the button.  

Graphics | Thumbnail | Mask 

The default buttons available in the Buttons window have masks that define the shape of the 
button.  The default masks are obviously part of the application as they were in version 1, but in 
version 2, you can assign your own custom masks to buttons. 

For the buttons that you have in your project right now, the mask defines a circular area. You can 
see in Figure 32 (and hopefully in the project you are creating as you follow along) that when a 
button contains no graphic, the mask shows up as a dark shape. When you add a graphic with 
the Thumbnail property, the mask is not visible, but “cuts” the shape of the graphic.  

 

Figure 32 
Remove the thumbnail image from the button to see the mask as a dark blue circle. 

 

To see how the mask effects your button, select the button on your menu that contains the 
graphic you added to it with the Thumbnail property. Notice that the graphic fits perfectly into 
the circular button. That’s because the mask cuts a circular figure, even though (as you can see) 
the button has a square bounding box (the area that defines the actual button, as opposed to the 
button graphic.)  Now, click the drop-down arrow for the Mask property and click the Clear 
Filename button. Figure 33 shows that the graphic now appears in its original rectangular form, 
even though that causes the thumbnail to be seen outside of the circular button frame (we’ll talk 
about button frames shortly.) Click the Undo button to take the button back to its masked state.  
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Figure 33 
With the button mask removed, you can see the entire file used for the button thumbnail. 

 

Graphics | Thumbnail | Start Time 

When you specify a video file for the Thumbnail, you can set the Start Time property to 
determine which frame of the video appears in the button. Enter a specific value in the Start Time 
field, or click the drop-down arrow and use the slider control to find the desired frame. 

Graphics | Thumbnail | Style 

When you specify a video file for the Thumbnail, you can choose to have the frame specified in 
the Start Time property appear as a still image (choose Still) or have the thumbnail appear as a 
full-motion video that starts on the frame specified by the Start Time (choose Animated). 

Graphics | Frame 

Your buttons can also have frames. Frames give you an opportunity to modify the look of your 
buttons. For instance, the buttons that we’ve been working with have a circular frame made up of 
a gold color and a light shadow. The frame typically has a transparent center so that you can see 
through it to the thumbnail image you are using. 

Use the Frame property to apply a frame to, or remove a frame from, a button. Click on the 
button in your project that does not contain the graphic thumbnail. Click the drop-down arrow 
for the Frame property and click the Clear Frame button. The button’s frame disappears as 
shown in Figure 34. Notice that unlike when you remove the mask, removing the frame does not 
alter the shape of the graphic that you can see. You can still see the mask outline in your button. 
Click the Undo button to put the frame back. 
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Figure 34 
Click the Clear Frame button to remove the frame from the button. 

 

 

Graphics | Frame | Mask 

As we mentioned, frames typically have a transparent center so that you can see through them to 
the thumbnail graphic that you’ve applied to the button. When a button uses a still image for a 
frame, the image is saved in a file format that supports transparency (typically .png) so that the 
artist simply builds transparency into the artwork. However, buttons also support file formats 
that do not support transparency (for instance, .jpg and .gif.) When the image used for the frame 
does not support transparency, you can use the Mask property to include a mask file that cuts a 
hole in the frame through which you’ll be able to see the thumbnail. 

From the Buttons window, choose Animated 1 from the Source drop-down list. Three buttons 
appear in the window. Hover your mouse over the middle button and notice that the thumbnail 
image has an animated frame. Add a new button to your project using this button style. Use the 
Thumbnail property to add a graphic to the button as in Figure 35. 

Figure 35 
Click the Change Filename button in the Graphics | Thumbnail and browse to a file to use as the button thumbnail image. 

 

 The button’s Frame property shows that the frame uses a .gif file. (In fact, it uses and animated 
.gif file, although it doesn’t have to.) That’s what creates the animated frame.  Since .gif files don’t 
support transparency, the button requires a frame mask to cut a hole in the center. The Mask 
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subproperty under the Frame property shows that a frame has been applied to this button. That’s 
what enables you to see the Thumbnail graphic in the button.  

To really see what’s going on, click the drop-down arrow for the Mask property (under the 
Frame property) and click the Clear Filename button. Figure 35 shows the result. Since the 
frame’s file format does not support transparency, the color used for the inside (and, for that 
matter, the outside) of the frame shows through. This demonstrates how the mask cuts the hole 
in the frame so that you can see the thumbnail. 

Figure 35 
With the Frame Mask deleted the thumbnail image is obscured by the frame. 

 

Graphics | Frame | Start Time 

This property works just the same as the Start Time property under the Thumbnail heading 
except that it applies only to the file you specify as the frame in the Frame property. 

Graphics | Frame | Style 

This property works just the same as the Style property under the Thumbnail heading except that 
it applies only to the file you specify as the frame in the Frame property. 

Highlight | Style 

Use this property to choose the type of highlight you want to use on the button when the viewer 
navigates to it. You’ll recognize all of the highlight styles from version 1, with the exception of 
the Custom option. The Custom style enables you to specify a graphic or video file that you want 
to use as a highlight mask. To use a custom highlight, choose Custom from the drop-down list, 
then specify a mask and a mask mapping technique as discussed in the following two sections. 

Highlight | Mask 

When you set the Style property to Custom, you then set the Mask property to the file that you 
want to use as the highlight mask. Click the drop-down arrow and browse to the file you want. 
Later in this document, we’ll show you how to create the artwork you use as your mask and 
discuss this property in detail. 

Highlight | Mask Mapping 

Click the drop-down arrow for the Mask Mapping property and choose the desired option from 
the list. You’ll learn more about masks and mask mapping later in this document. 

Navigation 

The Navigation property enables you to control what button on the menu will be selected when 
the viewer presses a certain navigation button (Left, Right, Up, or Down) on his/her remote 
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control device. Set this property to Auto for each direction if you want the software to determine 
which button should be chosen (the software makes this determination based on your button 
layout.)  

An example will help you see how you can override this Auto behavior. Start a new project, and 
add three buttons next to each other in a horizontal row to Menu 1. Add three more menus to 
your project (you should have a total of four menus.) Back on Menu 1, link the button on the left 
to Menu 2, the middle button to Menu 3, and the right button to Menu 4. Click the Preview 
button and use the arrow keys on the virtual remote device to highlight the various buttons. By 
default, the buttons Navigation properties are all set to Auto, and the software makes the 
navigation decisions for you. Note in specific that when the middle button is highlighted, clicking 
the Left remote arrow causes the left button to be highlighted. In a moment, you’ll override this 
behavior. Close the Preview window. 

In the Workspace, click the middle button. Change it’s Navigation | Left property to 3: Link - 
Menu 4 (Page 1). Click the Preview button and use the arrow keys to highlight the middle 
button. Now click the Left button on the virtual remote. This time the Right button is highlighted 
because of the setting you chose for the middle button’s Navigation | Left property. You can map 
each of the other arrow keys for this button in the same way. 

Working with Picture Compilation properties 

To explore Picture Compilation properties, start a new project, and insert a picture 
compilation at Menu 1. Navigate into the compilation, and add several pictures to the 
Compilation window. Now go back to the Properties window. 

Notice that when you’re navigated into a picture compilation, the Properties window has only 
two main headings: Picture Compilation Properties and Color Sets. We’re interested in Picture 
Compilation Properties now, so click the Minus (-) sign next to the Color Sets heading to hide all 
of its subheadings. If necessary, click the Plus (+) sign next to the Picture Compilation Properties 
heading to expand it. 

Track Media 

The Track Media subheading lists all of the audio tracks that you’ve added to your compilation. 
Since you haven’t yet added any additional audio tracks, the list contains only Audio 1, the 
default audio track for the compilation. Click the drop-down arrow for the Audio 1 property, and 
click the Change Filename button to browse to and select an audio file that you want to place on 
audio track one. 

In the Timeline window, insert an additional audio track. Notice that back in the Picture 
Compilation section of the Properties window, you now have two Audio tracks listed under 
Track Media. You can add an audio file to track two in the same way that you added audio to 
track one. To clear the audio file from either track, click the drop-down arrow for the track and 
click the Clear Filename button. 

End Action 

Use the End Action properties to dictate what happens upon completion of the picture 
compilation. Choose Link from the Command property if you want to take the viewer to a 
specific menu, media file, or another compilation when they finish viewing this one. Choose Stop 
to make the DVD stop playing after the last slide in the compilation. 

All of the other properties in this section work just the same as the button properties of the same 
names that we have already discussed. 
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Remote Buttons 

We talked about the Remote Buttons properties earlier during our discussion of Menu Page 
Properties. The Remote Buttons properties in the Picture Compilation Properties work exactly the 
same way. They enable you to enable or disable specific buttons on the viewer’s remote control 
device as he or she watches the picture compilation. 

Setting your Music Compilation Properties 

The properties in this section fall under two subproperty headings: End Action and 
Remote Buttons. These properties work identically to the properties of the same name that we 
just discussed for Picture Compilation Properties. 

Setting your Media Properties 

Insert a media file into your project (choose a video file.) Navigate into the media file, a
expand the Media Properties heading in the Properties window. The properties in this sectio
nearly identical to those in the Picture Compilation Properties heading that we discussed ea
The only difference is that the Track Media heading includes the Video property. This pro
enables you to change or clear the file that you link to for this media. Click the drop-down arro
and click the Change Filename button to choose a new media file, or click the Clear Filename 
button to remove the video file. 

nd 
n are 

rlier. 
perty 

w 

Note that DVD Architect software treats the video and audio portions of the media file 
independently so that you can change one without changing the other. 

Besides this difference, the remaining properties are identical to and operate in the same way as 
do those of the same name that we already talked about in the Picture Compilation Properties 
discussion earlier. 

Setting Subtitle Properties 

In the Timeline window, add a subtitle track to the media file that you inserted into your 
project in the previous section. Add a few subtitle events to the track. Click on one of the subtitle 
events in the Timeline window. Notice that the Properties window now lists Subtitle Properties. 

There is just one subtitle property: Colors. Use the Colors property to choose which color set you 
want to use for your subtitles. Click the drop-down arrow for the Colors property, and choose the 
desired color set from the list. Notice that DVD Architect software normally reserves Color Set 4 
for use with subtitles.  

VIII: Masks 
During our discussion of the Properties window, the techniques of masking came up several 
times. In this section we’ll discuss masking in detail. You’ll learn why and where to use them, as 
well as how to make your own custom masks. The masking capabilities of DVD Architect 2 
software make it possible to completely customize your DVD interface. 

Creating custom masks for your button graphics 

Earlier we talked about how some buttons use masks to control the appearance of the 
button thumbnails and button frames. We mentioned that you can create custom masks that you 
can use on your buttons. Let’s talk about how you create those masks. 

The masks that you apply to button thumbnails and frames are relatively simplistic. These masks 
are made up of shades of black. Typically, they are simply two colors--completely black or 
completely white—but could also contain shades of gray. When you lay a mask over a graphic 
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file, only the areas of the mask that are white allow the graphic to be seen. In other words, the 
white portion of the mask cuts the hole through which you see the graphic beneath. 

Thumbnail masks 

Let’s see it in action. Start a new project, click the Show Framed Buttons button in the Button 
window, and choose Corporate 2 from the Button Source drop-down list. Add the button to your 
menu. Click on the button in the Workspace to select it if it’s not already selected. In the 
Properties window, go to the Button Properties for this button. Under the Graphics heading, use 
the Thumbnail property to apply a thumbnail graphic to the button as shown in Figure 36.  

Figure 36 
Button with thumbnail graphic applied 

 

Note that this button has a default mask applied to it. Figure 37 shows the file that this button 
uses as the mask.  

Figure 37 
This figure shows the button mask that was used for the button in Figure 36. 

 
You can see that the mask graphic is simply a black square with a white circle in the middle. It’s 
the white circle that defines the shape of the button thumbnail you see. The black areas treat the 
thumbnail as if it were transparent. 

Use a graphics program to create a file like the one in Figure 37 except that instead of a white 
circle, create a circle that uses a radial blend (white in the center to black on the edges) as in 
Figure 38. Save it as RadialBlend.png (if you can’t make .png files with your graphics application, 
choose .jpg or .gif.) 
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Figure 38 
Mask using RadialBlend.png 

 

Now apply the RadialBlend.png file to the thumbnail Mask property for the button in your DVD 
Architect 2 software project. You can see that the button graphic now has feathered edges created 
by the varying amounts of white in the mask file. See Figure 39 to see what our button looks like. 

Figure 39 
Button with RadialBlend.png mask applied 

 

Your button masks (and therefore, the visible shapes of your buttons) do not have to be perfect 
shapes like circles and squares. Experiment with other shapes to see the different kinds of buttons 
you can create. For example, create a mask in the shape of a car or a tree and apply it to your 
buttons to see how the buttons look in that shape. 

Frame masks 

Frame masks work exactly the same way as thumbnail masks—they simply have a different 
shape. Start a new project. In the Buttons window, choose Animated 1 from the Button Source 
drop-down, and add the middle of the three buttons to your Workspace. Add a thumbnail 
graphic to the button. 

Recall that this button uses an animated .gif file for the frame. Figure 40 shows one frame of this 
.gif file graphic. Notice that the inside of the frame is black since .gif files do not support 
transparency. For this reason, the button contains a frame mask to cut a hole in the .gif file so that 
you can see the thumbnail graphic.  
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Figure 40 
The inside of this frame mask is black since .gif files do not support transparency. 

 

The Frame Mask property tells you the name of the file that this button uses as a mask. Figure 41 
shows what the frame mask file looks like. 

Figure 41 
The white portion of the frame mask will allow the frame graphic to show through. 

 

Again, the white areas of the frame mask allow the frame graphic to show through while the 
black areas cut the holes in the frame so that you can see through to the button thumbnail. As 
with the thumbnail mask, you can create frame mask with varying shades of gray as well as 
frame masks in any shape you want. 

Creating custom highlight masks 

Earlier in this document, we talked briefly about masks that you use to customize your 
button highlighting. Let’s see how these masks work and how to create them. 

Menu background media highlight masks 

The background media highlight mask property works great for creating custom highlights when 
you want to create your DVD interface in a graphics application or even in Vegas 5 software. 
Figure 42 shows a menu page graphic that we created in our Graphics program. 
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Figure 42 
Example of a custom menu created in a graphics program. 

 

Notice that we’ve created the button artwork along with the rest of the menu background. Create 
something similar in your graphics program so you can follow along with the rest of this 
discussion. 

Now, start a new DVD Architect 2 software project. In the Properties window, set the 
Background Media Video property to use this artwork. Delete the “Menu 1” title. Now, insert 
four empty buttons (choose Insert | Empty Button) into your project. For each button, set the 
Button property style (under the Graphics section) to Image only, and the Style property (under 
the Highlight section) to Custom. Position one button over each of the four animals and their 
corresponding name labels. Resize the buttons to make sure each button encompasses the entire 
animal artwork and the name as shown in Figure 43.  

Figure 43 
Place invisible buttons around each of the animal pictures and their names, and resize the buttons to fit both the picture and the 
name. 

 

Preview the project. Notice that no button is highlighted. Click the various arrows on the virtual 
remote control device and see that no matter how you navigate, no highlights appear on these 
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buttons. This is where the Highlight mask property under the Background media heading comes 
in. First, you need to create the highlight mask artwork. Figure 44 shows the menu artwork in 
our graphics program with the addition of our highlight artwork. 

Figure 44 
Menu with addition of highlight artwork. 

 

There are a couple of things to notice about the highlight artwork. First, we painted it with one 
color: Black. However, you’ll notice that, although we could have used solid black, we chose 
instead to use various shades of gray—or in other words, black with different transparency 
values. There are a couple of important points that you can’t notice from the figure. First, we 
created the highlight artwork on a separate layer in our graphics program. We devote this layer 
exclusively to the highlight artwork. We do this so that we can isolate the artwork and save it out 
as a separate file. Second, the layer that holds our highlight artwork has a transparent 
background. Create similar highlight artwork on a separate transparent layer in your menu art 
file. 

When your highlight art is complete, hide all of the layers except the highlight artwork layer as 
shown in Figure 45. In the figure, everything that shows in white is actually transparent in our 
file. 

Figure 45 
Save the highlight artwork layer as a separate file. 
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Save the highlight artwork in a file format that support transparency (we use .png), and name the 
file MenuMask (for example, our file is called MenuMask.png.) 

Back in DVD Architect 2 software, go to the Menu Page Properties in the Properties window. 
Under the Background Media section, set the Highlight mask property so that it uses the 
MenuMask file you just created. You’re almost ready for the big payoff, but first you have to set 
the Highlight mask mapping property. Set that property now to Transparency. 

At this point, you might want to quickly review our discussion of color sets from earlier in this 
document. We’ll focus on Color Set 1 to illustrate how highlight mapping works. Recall that the 
Selected button colors property is set by default to use Color Set 1. This means that Color Set 1 
determines the colors used to highlight the selected button on the DVD interface.  

When you set the Highlight mask mapping property to Transparency, DVD Architect assigns the 
first color in the set to the least transparent portion of the mask, the second color to portions that 
are a bit more transparent, the third color to portions that are even more transparent, and the 
fourth color in the set to the most transparent portion of the mask. (If you’re interested, the DVD 
Architect 2 software’s on-line help files give you some exact numbers of where these delineations 
occur. The help files also give explanations on the other two settings for the Highlight mask 
mapping property and how they assign the four colors from the color set.) 

We’ve changed the colors in Color Set 1 for our project to match the green used in the words “the 
zoo.” To do this on your menu, click the drop-down arrow for Color 1 and then click the Pick 
color from screen button (the eyedropper button), and click one of the letters in the word “zoo.” 
This samples that color, and changes Color 1 to match it. Since Color 1 represents the most 
opaque portions of the highlight artwork, set its Alpha value to 255 (completely opaque.) 

Now sample the same color for both Colors 2 and 3. Set the Alpha value for color 2 to 191, and 
the Alpha value for color 3 to 84. These settings represent even steps for the transition between 
fully opaque to fully transparent. They are a good starting point, but you may want to tweak the 
values a bit to get the exact effect you’re after on your artwork. Figure 46 shows what our Color 
Set 1 looks like now that we’ve adjusted the color values. 

Figure 46 
Adjust the color set to match the color of the interface title. 

 

Now you’re ready to see the results. Click the Preview button. You’ll notice that one of your 
buttons contains a green highlight as shown in Figure 47. Why is the highlight green, and why 
does only one of the highlights show up when we know the mask contains four highlights? 
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The selected button on the interface interacts with the highlight mask so that only the 
(nontransparent) areas of the mask that touch the selected button show up. That’s why you see 
only one button highlighted. The green color of the highlights comes from the green settings you 
specified in Color Set 1. 

Figure 47 
The button highlight makes use of the new Color Set settings 

 

Use the various arrow buttons on the virtual remote control device to navigate to the other 
buttons and notice how the highlight changes according to which button you select. 

Custom button highlight masks 

The technique we just discussed for creating button highlights using menu background media 
highlight masks works great for those times when you want to design the layout of your menu 
completely in a graphics application. Other times however, you may want to have the flexibility 
of changing the layout of your menu buttons in DVD Architect 2 software without having to 
return to your graphics application and adjust the artwork there. For these times, you can use 
custom button highlight masks. 

To illustrate how this works, we’ve modified our menu artwork so that it no longer contains the 
zebra or the raccoon as shown in Figure 48. 
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Figure 48 
The menu art work has been modified so that it no longer contains the zebra or raccoon button artwork. 

 

We’ve also created separate artwork for both the zebra and the raccoon buttons, including 
highlight artwork for each. Figure 49 shows these pieces of art. Create similar artwork of your 
own to use as you follow along with our example. Call them ModifiedMenuArt, RaccoonArt, 
RaccoonArtMask, ZebraArt, and ZebraArtMask. 

Figure 49 
Save the art work for each button and its mask as a separate file. 

 
Start a new project in DVD Architect 2 software. Add the ModifiedMenuArt file to the menu 
background. Choose Insert | Empty button twice and position the buttons in the blank area of 
the menu. Select both of the buttons simultaneously and choose Image only for the Button style 
property under the Graphics heading in the Button Properties. Also, in the Highlight section, 
choose Custom for the Style property. 
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Now select just one of the buttons. Under the Graphics heading, set the Thumbnail property to 
point to the RaccoonArt file and the Mask property under the Highlight heading to use the 
RaccoonArtMask file. Similarly, set the other button to use the ZebraArt and ZebraArtMask files. 

So far, the menu looks very much like it did before you started this section of the document. The 
difference is that now the zebra and raccoon buttons are completely moveable. Drag one of the 
buttons to a new location and notice that now the artwork comes with it as you drag the button 
because the artwork is assigned to the DVD Architect 2 software button. 

Use the same techniques we discussed earlier to change the colors in Color Set 1 if you want to 
change the color of the highlights used on these buttons. 
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IX: Conclusion 
In this document, you’ve seen that version 2 is an exciting and powerful upgrade to DVD 
Architect software. Many of the new features make it easier to get your DVD preparation job 
done, while others bring powerful new functionality to the process. With DVD Architect 2 
software and the knowledge that you’ve gained from this document, you are armed and ready to 
create nothing less than the highest-quality DVD projects that you can imagine. 

We hope this document has helped you get a handle on all of the impressive new features of the 
software, and we wish you the best of luck on your upcoming DVD authoring projects!  
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